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0 getSoft Installation 

Before you connect the getSpec–2048 spectrometer to the USB port of your computer, you 
have to install the getSoft software. 

GetSoft version 7 is a 32-bit application and can be installed under the following operating 
systems: 

o Windows 95/98/Me  
o Windows NT/2000/XP 

If the operating system is Windows 95 or Windows NT4.0, use a standard RS-232 cable (with 
male and female DB-9 connectors) to connect the getSpec–2048 to the serial port of the 
computer. 

Installation program 

Every new spectrometer system includes a getSpec.com product CD-ROM. After the 
CD-ROM is inserted in the CD-ROM drive the main menu shows the option “Install getSoft 
software”. After selecting this option a submenu is displayed in which the spectrometer 
configuration can be selected.  

The getSpec–USB1 group of spectrometers should be selected to install getSoft for one of 
the following spectrometer types:  

o getSpec-102 or getSpec-102-y 
o getSpec-256 or getSpec-256-y 
o getSpec-1024 or getSpec-1024-y 
o getSpec-2048 or getSpec-2048-y 
o getSpec-2048FT or getSpec-2048FT-y  

In which y represents the number of spectrometer channels.  

The getSpec-USB2 group of spectrometers should be selected to install getSoft7 for one of 
the following spectrometer types: getSpec–102/256/1024/2048/3648/NIR256-USB2. 

Instructions below are for the getSpec-USB1 and -USB2 spectrometers, -Bluetooth 
instructions are found in section 0.1. 

Installation Dialogs 

The setup program will check the system 
configuration of the computer. If no problems 
are detected, the first dialog is the “Welcome” 
dialog with some general information.  

In the next dialog, the destination directory for 
the getSoft software can be changed. The 
default destination directory is 
C:\getSOFT7USB2. If you want to install the 
software to a different directory, click the 
“Browse” button, select a new directory and 
click “OK”. If the specified directory does not 
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The file „getUSB.sys“ on getUSB 
Installation Disk is needed.  

exist, it will be created. 

In the next dialog, the name for the program manager group can be changed. The default 
name for this is “getSpec Software”. 

After this the “Start Installation” dialog is shown. After clicking the “Next” button the installation 
program starts installing files. After all files have been installed the “Installation Complete” 
dialog shows up. Restart the computer before starting getSoft.  

Connecting the hardware 

Connect the USB connector to an USB port on your computer with the supplied USB cable. If 
the spectrometer type is a getSpec-SPU, put the switch into SPU position. If the getSpec-
2048 spectrometer requires a 12 V power supply, connect the getSpec-2048 to the 12 V 
power supply. Windows will display the “Found New Hardware” (USB device) dialog, and 
starts searching for the driver. This can take a few minutes. 

Under Windows XP, a window will be 
displayed that the getspec 
Spectrometer board "has not passed 
Windows Logo testing to verify 
compatibility with Windows XP" 
(which indicates that the 
manufacturer of the USB driver did 
not send it to Microsoft (and also paid 
Microsoft) for testing of this driver, as 
it will be the case for all drivers 
developed for Windows 2000, which 
also work fine under Windows XP):  

Select "Continue Anyway”. 

 

Depending on the Windows version, the dialog at the right may come up, which allows you to 
browse to the directory where the USB 
driver is located. Click the “Browse” 
button and browse to the directory: 
C:\WINNT\SYSTEM32\DRIVERS and 
double click the getUsb.sys driver or for 
the USB2 platform the get5216USB.sys 
driver. 

If the computer does not support USB 
(Windows 95, Windows NT 4.0), use a 
standard RS-232 cable (with male and 
female DB-9 connectors) to connect the 
getSpec-2048 to the serial port of the computer. 
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0.1 Bluetooth installation 

The getSpec spectrometers with Bluetooth wireless data transfer support are shipped with a 
Tornado USB dongle. A Bluetooth driver installation CD is included in the Tornado USB 
dongle package. This section describes how to set up Bluetooth data communication with the 
getSpec-Bluetooth spectrometer. 

Install getSoft for USB2 spectrometers from the getSpec Product CD-ROM 

Insert the getSpec Product CD-ROM in the CD-ROM drive of the PC, select “Software 
Installation” and install getSoft. 

Install Bluetooth driver 

Insert the Tornado Installation Disc into the CD-ROM drive of your PC and follow the on-
screen instructions. After the installation has been completed you will be asked to restart the 
computer. After the restart the IVT BlueSoleil window is shown. Insert the Tornado USB 
dongle. 

Connect the 12 V DC external power supply or battery pack to the getSpec 

First make sure that the battery pack is completely charged. If not connect the battery pack to 
the charger and let it charge until the LED on the charger starts to flicker (trickle-charge 
mode). Now connect the battery pack to the getSpec and switch on the battery pack (switch 
on the front side) and switch on the getSpec to external power. 

Search for getSpec Spectrometer Device  

The green power LED at the front side 
of the spectrometer should be on. 

Select the menu option “Refresh 
Devices” in the IVT BlueSoleil Main 
Window as shown in the dialog at the 
right.  

Pair Device 

The getSpec will be displayed by an 
icon in the ring with an address and a 
question mark.  

Right clicking this icon shows the 
menu displayed in the figure at the 
right. Select the “Pair Device” menu 
option. Enter “0” in the Bluetooth 
passkey dialog and click “OK”. 

Establish data communication 

Select the “Refresh Services” menu 
option after right clicking the device 



 

 
info@getSpec.com 

 
Tel. : +49 (0) 351 871 8423   Tél. : +33 (0) 4 72 80 82 02   Tel. : +49 (0) 231 974 2285   
Fax : +49 (0) 351 871 8465   Fax : +33 (0) 4 72 80 82 43   Fax : +49 (0) 231 974 2286 
             
    

• Dresden • Lyon • Dortmund • Sofia 
Seite 8 

 

 

…more than spectroscopy! 

icon. As a result the Bluetooth Serial Port Service icon will be marked. Right clicking the 
Bluetooth device icon again now 
shows a new menu option: Connect. 

After clicking “Connect Bluetooth serial 
port device” a virtual serial port number 
is assigned for this connection. Click 
“Yes” in the dialog at the right to 
connect automatically if Windows 
opens this serial port. You will need to 
enter the port number (in this example COM8) 
later in getSoft.  

Data communication has now been 
established, which is illustrated by a line 
between the device and the PC.  

By clicking the menu option “Tools – 
Configurations – Quick Connect”, the COM 
port number that has been assigned for the 
data communication between the spectrometer and the PC can be verified.  

Starting getSoft 

getSoft can be started after data communication 
has been established. The first time that getSoft 
is started for the Bluetooth spectrometer, it will 
show the dialog at the right. 

Click the option: “Retry to establish 
communication through RS-232 or Bluetooth”. A 
list with available comports will be displayed. In 
our example, COM8 has been selected for the 
Bluetooth data communication. Select the right 
COM port from the list and click “OK”. getSoft will 
now read the configuration data from the 
spectrometer (this can take about 15 seconds), 
after which measurements can be started. 
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0.2 Launching the software 

getSoft can be started from Windows start menu. Under “Start -> Programs” the group 
“getSpec Software” was added. This group contains two icons. With the getSpec-chameleon-
icon, getSoft is started. The getSoft Help icon can be used to activate the getSoft help files 
(these help files can also be activated from the help menu after starting getSoft). 

 
 

USB1 platform 

After starting getSoft, the dialog at the right 
will be shown to indicate that the USB 
connection has been detected (a similar 
dialog will be shown if the serial RS-232 
interface is used). 

If more than one getSpec–2048 spectrometer is connected to 
the PC, the dialog at the right will be shown which allows to 
select the spectrometer serial number for which you want to use 
getSoft. With USB1 platform spectrometers you can run multiple 
spectrometers simultaneously, just by restarting getSoft multiple 
times. After clicking the “OK” button, the main window is 
displayed.  

USB2 platform 

After starting the “getSoft 7” software, all connected spectrometers will be recognized 
automatically and the serial numbers will appear as labels on the right hand of the screen.  

After clicking the “Start” button all connected spectrometers will be displayed in the main 
window. 

After clicking the “OK” button, the main window is displayed. Refer to section 2 for a 
description about the main window components. A “Quick Start” can be found in section 1, if 
you want to start measuring immediately. Detailed information about the menu options is 
found in section 3.  

Depending on the getSoft version (Basic or Full) and the extra add-on modules that were 
ordered for your spectrometer, up to six applications are available in getSoft, which are 
described in sections 4.1 to 4.6:  
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1. History (standard in getSoft FULL) 
2. Wavelength Calibration (standard in getSoft FULL) 
3. Color Measurement (add-on module) 
4. Irradiance Measurement (add-on module) 
5. Excel Output (add-on module) 
6. Chemometry (add-on module) 

 

1 Quick Start: Measuring and Saving a Spectrum 

1. After starting getSoft, the green “Start” button needs to be clicked to start measuring. 

2. Connect a fiber or probe to the light source and to the spectrometer input port(s) and set 
up the experiment for taking a reference spectrum.  

3. Adjust the smoothing parameters  in the setup menu (section 3.2.3) to optimize 
smoothing for the fiber/slit diameter that is used (for USB2 platform getSpec’s optimal 
smoothing is preset and stored on board in the EEPROM). 

4. Now turn on the light source. Usually some sort of spectrum may be seen on the screen, 
but it is possible that too much or too little light reaches the spectrometer at the present 
data collection settings. Too much light means that, over a certain wavelength range, the 
signal is saturated shown as a straight line at the maximum counts and the appearance of 
the label “Saturated” in the status bar of the spectrometer channel. This can usually be 
solved by a shorter integration time.  

The integration time can be changed in the main window, in the white box below the 
“Start/Stop” button. If getSoft is collecting data, the “Start/Stop” button shows a red „Stop“ 
and the integration time box is gray, indicating that it cannot be changed (USB1). After 
clicking the “Stop” button the data acquisition stops and the integration time can be 
changed. The result of the changed integration time can be viewed after clicking the green 
“Start” button. Try to adjust the integration time, such that the maximum count over the 
wavelength range is around 14500 counts. When at minimum integration the signal is still 
too high, an attenuator, a neutral density filter or fibers with a smaller diameter may be 
used. When not enough light reaches the spectrometer, likewise a longer integration time 
should be entered.  

5. When a good spectrum is displayed, turn off the light source. 

6. Now save the Dark data. This is be done by “File -> Save -> Dark” from the menu or by 
clicking the black square on the left top of the screen with the mouse. Always use “Save 
Dark” after the integration time has been changed.  

7. Turn on the light source again. Save the present spectrum as a reference by choosing 
“File -> Save -> Reference”  from the menu or by clicking at the white square (next to the 
black one). Always use “Save Reference” after the integration time has been changed. 
Now the transmittance/reflectance (“T” button) or absorbance (“A“ button) spectra can be 
obtained online. To have a better look at the amplitude versus wavelength, the cursor 
button can be clicked. A vertical line is displayed in the graph. If the mouse cursor is 
placed nearby this line, the shape of the mouse cursor changes from an arrow to a „drag“ 
shape. If this shape is displayed, the left mouse button can be used to drag (keep left 
mouse button down) the line with the mouse towards a new position. Moving this line 
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shows the corresponding values of wavelength and amplitude in the main screen. By 
clicking the red “Stop” button, the data acquisition is stopped and the last acquired 
spectrum is shown in static mode. The data acquisition can be started again by clicking 
the same button, which now shows a green “Start”. 

8. To save the spectrum (in the mode chosen before), choose “File -> Save -> Experiment” 
from the menu, or click the “Save Experiment” button from the button bar. 

9. To improve the signal/noise ratio a number of spectra can be averaged. To do this the 
value in the white average box in the main window (next to integration time) can be 
increased. The value can be changed only in static mode. When getSoft is acquiring data 
the average box becomes gray. 
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2 Main Window 

2.1 Menu bar 

 
The menus and submenus are described in section 3. 

2.2 Button bar 

- For the USB1 platform  

 
 

 
- For the USB2 platform 

 
 

   Start/Stop button 

The “Start/Stop” button can be used to display data real-time or to take a snapshot 

   Cursor button 

After clicking the “Cursor” button, a vertical line is displayed in the graph. If the mouse cursor 
is placed nearby this line, the shape of the mouse cursor changes from an arrow to a “drag” 
shape. If this shape is displayed, the left mouse button can be used to drag (keep left mouse 
button down) the line with the mouse towards a new position. Moving this line shows the 
corresponding values of wavelength and amplitude in the 
main screen. As an alternative for dragging the line, the 
small step and big step arrow buttons may be used, or the 
left and right arrow keys on the keyboard. The step size for 
the arrow buttons can be changed by holding down the 
CTRL-key while clicking at a (single or double) arrow button.   

   Save reference and dark buttons 

The “Reference” button is the white button at the left top of the screen. It needs to be clicked 
to save the reference data. The same result can be achieved with the option “File -> Save -> 
Reference”. 

The “Dark” button is the black button at the left top of the screen. Click it to save the dark data. 
The same result can be achieved with the option “File -> Save -> Dark”. 
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   Save experiment button  

By clicking the “Save Experiment” button an experiment is saved. The same result can be 
achieved with the option “File -> Save -> Experiment”. 

   Print button 

By clicking the “Print” button a graph that is displayed on the monitor will be printed. The same 
result can be achieved with the option “File -> Print”. 

   Channel button (USB1 platform only) 

After clicking the “Channel” button, a dialog is shown in which the spectrometer channels can 
be selected, for which data will be acquired and displayed. The same result can be achieved 
with the option “View -> Channel”. 

   Scope button 

By clicking the “S” button, the data will be presented in scope mode. The same result can be 
achieved with the option “View -> Scope Mode”. 

   Absorbance button 

By clicking the “A” button, the data will be presented in absorbance mode. The same result 
can be achieved with the option “View -> Absorbance Mode”. 

   Transmission button 

By clicking the “T” button, the data will be presented in transmittance mode. The same result 
can be achieved with the option “View -> Transmittance Mode”. 

   Irradiance button 

By clicking the “I” button, the data will be presented in irradiance mode. The same result can 
be achieved with the option “View -> Irradiance Mode”. 

   Auto scale y-axis button 

By clicking this button, the graph will be rescaled on-line. A maximum signal will be shown at 
about 75 % of the vertical scale. The same result can be achieved with the option “View -> 
Autoscale y-axis”. 
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   Change Graph Scale button 

By clicking this button, a dialog will be shown in which the range can be changed for both x- 
and y-axis. This range can be saved as well and restored any time by clicking the “Goto 
Preset Scale” button (see below). The menu option with the same functionality is “View -> 
Change Graph Scale”. 

  Goto Preset Scale button 

By clicking this button, the scale for x- and y-axis will be set to a range that has been set 
before. The same result can be achieved with the menu option “View -> Goto Preset Scale”. 

   Graphic Reset button 

By clicking this button, the x- and y-axis will be reset to their default values. The same result 
can be achieved with the option “View -> Graphic Reset”. 

   Auto Configure Integration time button 

After this button is clicked, getSoft starts searching for an optimal integration time. Depending 
on the maximum counts in the last scan, the integration time will be increased/ decreased 
automatically until a scope signal of about 14500 counts is measured. During the search 
routine, the changes in integration time can be followed in the integration time edit box in the 
edit bar. A dialog will display the new integration time if the search is ready. The routine can 
be aborted by clicking the button again before the search has ended. 

   H.C.F. button 

The “History Channel Function” button allows you to switch directly to the history channel 
function screen to start measuring immediately. Of course first the functions need to be 
defined. 

The two buttons below are available only if getSoft has been ordered together with 
the color application add-on:  

   Color Chart button 

The “Color Chart” button allows you to switch directly to the color chart screen and starts 
measuring immediately.  

   Color of Object versus Time button 

The “Color of Object versus Time” button allows you to switch directly to the time 
measurement of color parameters and starts measuring immediately.  
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2.3 Edit bar 

- USB1 platform 

 
- USB2 platform multi-channel 

 
For USB1 when getSoft is acquiring data, the edit fields are gray and non-editable. By clicking 
the red “Stop” button, data acquisition is stopped and the edit fields become white and 
editable. The edit bar shows the following parameters: 

Integration time [ms] 

This option changes the CCD readout frequency and therefore the exposure or integration 
time of the CCD detector. The longer the integration time, the more light is exposed to the 
detector during a single scan, so the higher the signal. If the integration time is set too long, 
too much light reaches the detector. The result is that, over some wavelength range, the 
signal extends the maximum counts (16383) or in extreme case shows as a straight line at 
any arbitrary height, even near zero. Entering a shorter integration time can usually solve this. 
Try to adjust the integration time, such that the maximum count over the wavelength range is 
around 15000 counts. When at minimum integration the signal is still too high, an attenuator, 
a neutral density filter or fibers with a smaller diameter may be used. When not enough light 
reaches the spectrometer, likewise a longer integration time should be entered. It is also 
possible to let getSoft search for a good integration time by clicking the “?AC” button, or by 
using the menu option “Setup -> Options -> Auto configure Integration time”. 

If measurements are done in a mode in which reference and dark data are required (all 
modes except scope mode), then a new reference and dark spectra have to be saved after 
the integration time has been changed. 

Average 

With this option, the number of scans to average can be set. A spectrum will be displayed 
after every # scans. This spectrum is the average of the # scans. 

Wavelength [nm] 

The wavelength shows the position of the cursor, which becomes visible if the cursor button 
is down. The amplitude of the signal, which is given in the status bar at the bottom of the main 
window, is the amplitude at the wavelength shown in this field.  

Multi-channel USB2 only 

For multi-channel USB2 
spectrometers the integration time and averaging can 
be set for all channels at the same value by clicking “to 
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All”. If the dashed box is clicked, different integration time and averaging can be set per 
channel. 

2.4 Graphical region 

 
The graphical region displays the data in a xy-diagram, with the wavelength in nanometers at 
the x-axis, and at the y-axis the detector counts. After loading or saving a reference and dark 
spectrum, other units can be selected at the y-axis: Absorbance 
Units, Percentage Transmittance or Relative Irradiance. 

Display saved Graph and Line style editor 

By clicking on the legend with the right mouse button, 
earlier saved multiple spectra can be displayed. 

New in specSoft 7 is that displayed graphs can be 
deleted or properties of the displayed graphs, such 
as line style or color or comments can be changed. 
This is done by clicking with the right mouse button 
on the line in the graphical display. A small line edit box will occur.  

Now the line can be deactivated or the line properties can be changed as depicted in the 
border editor or the comments can be edited. 

Zoom features 

Zoom in: Select a region to be expanded to the full graph. To select this region, click the left 
mouse button in the white graphical region and drag it downwards and to the right. After 
releasing the left mouse button within the graphic display, both the x- and y-axis will be 
rescaled to the new values of the selected region. 



 

 
info@getSpec.com 

 
Tel. : +49 (0) 351 871 8423   Tél. : +33 (0) 4 72 80 82 02   Tel. : +49 (0) 231 974 2285   
Fax : +49 (0) 351 871 8465   Fax : +33 (0) 4 72 80 82 43   Fax : +49 (0) 231 974 2286 
             
    

• Dresden • Lyon • Dortmund • Sofia 
Seite 17 

 

 

…more than spectroscopy! 

Zoom out: Drag with the left mouse button within the white rectangle, but in stead of dragging 
the mouse downwards and to the right, drag it in another direction. After releasing the mouse 
button, both the x- and y-axis will be reset to their default values. 

Move X-Y: Dragging with the right mouse button results in moving the complete spectrum up 
or down and to the left or right. 

Move-Y: If a mouse-wheel is available on the mouse being used, then the spectrum can be 
moved up or down by moving the mouse wheel. 

2.5 Status bar 

USB1 

 
For each selected spectrometer channel, a status bar at the bottom of the main window 
shows information about the file to which the data will be saved, amplitude at current 
wavelength, and the current settings for the smoothing and spline parameters. The field at the 
right of the Spline setting is used to indicate that the spectrometer is receiving too much light 
at a certain wavelength range (= 16383 counts before correcting for dynamic dark, smoothing 
or averaging), in which case the label “Saturated” will become visible. (See also section 
“3.2.9.1 Setup Menu: Options – Check on Saturation”). 

USB2 

 
For each selected spectrometer channel, a status bar at the bottom of the main window 
shows the name label of the connected spectrometer channel, the file to which the data will 
be saved, amplitude at current wavelength, the current settings for the smoothing and spline 
parameters, the line color and style in the graphical display, the real integration time and 
averages per channel and final the number of scans taken since the “Start” button was 
clicked. The field at the right is used to indicate that the spectrometer is receiving too much 
light at a certain wavelength range (= 16383 counts before correcting for dynamic dark, 
smoothing or averaging), in which case the label “saturated” will become visible. 

2.6 Find peaks or valleys by CTRL or SHIFT + left mouse button click 

This option can be used in all modes (Scope, Absorbance, Transmittance or Irradiance) and 
for all displayed graphics. When the left mouse button is clicked in the graphical region, while 
the CTRL key is down, getSoft will follow the following procedure to run to the closest peak: 

1. The wavelength is determined from the position the mouse click occurred. 

2. The data from closest pixel is retrieved 

3. The direction to search for the peak is determined from the neighbor pixels. If both 
neighbor pixels have a lower value at the y-axis than the current pixel, the current pixel is 
already a peak. If only one of the neighbor pixel values is higher then the current pixel 
value, the peak will be searched in the direction of this higher pixel. If both neighbor pixels 
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have a higher value at the y-axis than the current pixel, the current pixel is in a valley. The 
peak will in this case be searched in the direction of this neighbor pixel with the highest 
value. 

4. The cursor starts moving in the direction, as determined under 3., until it reaches a pixel 
of which the value is not higher than the last one evaluated. At this pixel the cursor stops. 

By holding down the SHIFT-key instead of the CTRL-key, the same procedure will be used to 
move to the closest valley. 

If more than one spectrum is being displayed, a dialog, as shown at 
the right, pops up in which the spectrum for which the peak finder 
needs to be activated can be selected out of all displayed spectra. 
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3 Menu Options 

In sections 3.1 to 3.3 the main menu options (File, Setup and View Menu) and their submenus 
are described in detail. 

3.1 File Menu 

 

 

 

 

 

 

 

3.1.1 File Menu: Start New Experiment 

After selecting this option, a dialog box appears in which a new experiment name can be 
entered. The experiment name will be saved as a filename with the extension *.kon. This 
extension does not need to be entered.  

After clicking the “Save” button, the 
current filename will be built up from 
the experiment name that has been 
entered, and a sequence number, 
starting at 0001. 

Example: if the experiment name is 
“test”, the first graphic file that will be 
saved in scope mode, will be called 
test0001.ROH, the sequence 
number will be automatically 
incremented, so the next file that will 
be saved in scope mode will be 
called test0002.ROH etc. For 
detailed information on graphic 
filenames, see “3.1.7 File Menu: 
Save Experiment”. Note that the dialog allows you to select different folders or drives to save 
the experiments to, as well as creating a new folder name for the new experiment. For USB1 
platform the default folder in which data is saved is called “data <serialnumber>”, in which 
<serialnumber> refers to the serial number of the getSpec-2048 spectrometer that is being 
used, for USB2 platform the default directory is “data”. 

After closing the dialog box by clicking the “Save” button, the new experiment name, followed 
by its sequence number, is displayed in the lower left of the status bar. By clicking the 
“Cancel” button, the old experiment name will be restored. 
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3.1.2 File Menu: Load Dark 

With this option, dark data can be loaded, that have been saved before. If getSoft is in static 
mode, the dark data that will be loaded are shown on the screen first. 

3.1.3 File Menu: Load Reference 

With this option, reference data can be loaded, that have been saved before. If getSoft is in 
static mode, the reference data that will be loaded are shown on the screen first. 

3.1.4 File Menu: Load Experiment 

 

With this option, an experiment can be loaded, that has been used before. This way more 
spectra can be saved to an existing experiment. An experiment name has the file extension 
"*.kon". After choosing this option, a dialog box shows all experiments that were saved earlier 
in the current experiment directory. If the experiment name that needs to be loaded is in this 
directory, select it and click the “Save” button. If the experiment name that needs to be loaded 

is in another drive and/or directory, move to this directory by clicking the  behind the 
current folder name. For detailed information on graphic filenames, see section “3.1.7 File 
Menu: Save Experiment”. 

3.1.5 File Menu: Save Dark 

With this option, dark data are saved. For USB1 platform the name of the dark data file is 
"dark*.dat", where * represents the number of the slave channel for which the dark data has 
been saved (* = 0 represents the master channel). For USB2 platform the name of the dark 
data file is "serialnr.drk". 

The dark data files will be saved in the experiment directory that has been picked by the option 
“File -> Load -> Experiment” or “File -> Start -> New Experiment”. 
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3.1.6 File Menu: Save Reference 

With this option, reference data are saved. For USB1 platform the name of the reference data 
file is "ref*.dat", where * represents the number of the slave channel for which the reference 
data has been saved (* = 0 represents the master channel). For USB2 platform the name of 
the reference data file is "serialnr.ref". 

The reference data files will be saved in the experiment directory that has been picked by the 
option “File -> Load -> Experiment” or “File -> Start -> New Experiment”. 

3.1.7 File Menu: Save Experiment 

With this option, spectral data is saved. All graphic files will be saved in the experiment 
directory that has been picked by the option “File -> Load -> Experiment” or “File -> Start -> 
New Experiment”. 

Saving graphic files if one spectrometer channel is enabled 

First a window appears in which a line of comments can be entered to the saved graph. Than 
two files will be saved: the first file contains the saved spectrum data. The name of this first 
file starts with the experiment name, directly followed by the sequence number of the saved 
spectrum. The extension of this first file depends on the current measuring mode, as shown 
below: 

 Extension Mode 
 ROH  Scope Mode 
 ABS  Absorbance 
 TRM  Transmittance/Reflectance 
 IRR  Irradiance 

The second file contains the line of comments, which may have been added to this graph. 
The name of this second file is, except for the extension, the same as the name of the first file 
(experiment name and sequence number). The extension of this second file also depends on 
the measuring mode, as shown below: 

 Extension Mode 
 RCM  Scope Mode 
 ACM  Absorbance 
 TCM  Transmittance/Reflectance 
 ICM  Irradiance 

Example: suppose the name of our experiment is "gts". Then, saving one spectrum in scope 
mode, one in absorbance mode and two in transmittance mode results in the following files: 

gts0001.roh: spectrum data in scope mode 
gts0001.rcm: comments for the spectrum saved in gts0001.roh  
gts0001.abs: spectrum data in absorbance mode 
gts0001.acm: comments for the spectrum saved in gts0001.abs 
gts0001.trm: spectrum transmittance mode 
gts0001.tcm: comments for the spectrum saved in gts0001.trm  
gts0002.trm: spectrum data in transmittance mode 
gts0002.tcm: comments for the spectrum saved in gts0002.trm 
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After leaving the application and opening getSoft the next time, saving graphics in scope, 
absorbance and transmittance mode, will then result in respectively the data-files 
gts0002.roh, gts0002.abs and gts0003.trm, as well as the comment files gts0002.rcm, 
gts0002.acm and gts0003.tcm.  

Before saving, the name of the graphic file is displayed in the status bar at the bottom of the 
screen. After saving, the sequence number is automatically incremented by one. 

Saving graphic files if multiple spectrometer channels are enabled 

If graphic files are saved while more than one channel is viewed at the same time (see option 
“View Menu: Channel (only for USB1 platform)”), then the graphic filename for each channel 
that is displayed gets a different sequence number. For example, the result of saving one 
experiment in triple view mode is three graphic data files and three comment files, for 
instance: 

gts0002.roh: spectrum data in scope mode (e.g. spectrometer 1 or Master Channel) 
gts0003.roh: spectrum data in scope mode (e.g. spectrometer 2 or Slave1 Channel) 
gts0004.roh: spectrum data in scope mode (e.g. spectrometer 3 or Slave2 Channel) 
gts0002.rcm: comments for the spectrum saved in gts0002.roh 
gts0003.rcm: comments for the spectrum saved in gts0003.roh 
gts0004.rcm: comments for the spectrum saved in gts0004.roh 

For each channel a different comment line can be entered. 

It is easier to select the graphic files later with the option “File -> Display Saved Graph”, all 
comment lines start with a short name for the channel at which the graph has been saved: M 
for Master, S1 for Slave1 and so on. 

After saving, the sequence numbers in this example (triple view mode) will automatically have 
been increased to 0005, 0006 and 0007, for resp. Master, Slave1 and Slave2. 

3.1.8 File Menu: Print 

After selecting the print menu option, the 
background colors in the graphical region 
will become white. If the menu option 
“Black and White Printer” (see next 
section) has been marked, the line style for 
the spectra will also change from colored 
to black. A dialog will be shown in which 
the title for the printout can be entered. In 
the next window, the printer settings can be 
changed (e.g. portrait or landscape 
printing, printing quality). After clicking “OK” 
in the printer settings dialog, the graph will 
be printed, and the original graph colors will 
be restored on the monitor.  
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3.1.9 File Menu: Black and White Printer 

The default setting in getSoft is to print the spectra in the same color as they appear on the 
monitor. If a color printer is not available the menu option “Black and White Printer” can be 
enabled. If this option is enabled, different line styles will be printed if more than one spectrum 
is displayed, e.g. dash-dash, dot-dot, dash-dot. To enable this option click the menu option 
and a checkmark appears in front of it.  

3.1.10 File Menu: Display Saved Graph 

This option requires that 
graphic files were saved 
earlier by using the option “File 
-> Save Experiment”. After 
choosing this option, a window 
shows all files in the current 
measure mode. In the 
example at the right, the 
measure mode is “scope”, so 
the extension of the earlier 
saved spectra is *.ROH.  

To select graphic files that 
were saved in another 
measure mode, e.g. 

absorbance, click  behind the “Graph - …Mode”, and pick the desired measure mode. 

To select graphic files from another folder or drive, click  behind the current folder name. 

If a graphic file is marked by a (single) mouse click on the filename, the comment line for this 
file appears at the top of the graphical region in the main window. Selecting multiple filenames 
can be realized by using the CTRL or SHIFT key in combination with the mouse. If the CTRL 
key is pressed, all the files that are clicked by the mouse will be selected for displaying. If the 
SHIFT key is pressed, all the files in between two clicked files will be selected for displaying. 

Select the name of the file(s) to be displayed and click the “Open” button. To leave this dialog 
without displaying graphic files, click the “Cancel” button. 

New in getSoft 7 is that displayed graphs can be deleted or 
properties of the displayed graphs, such as line style or color or 
comments can be changed. This is done by clicking with the right 
mouse button on the line in the graphical display. A 
small line edit box will occur.  

Now the line can be deactivated or the line properties 
can be changed as depicted in the border editor or 
the comments can be edited. 

In the right figure two graphic files were selected in 
scope mode. The comments that were saved with 
these graphs are displayed at the top of the graphical 
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region, together with 
information about amplitude 
at current wavelength 
(amp), integration time (it) 
and smoothing (s) settings 
at the moment that the file 
was saved and the name of 
the graphic file. If the active 
spectrometer channels 
(e.g. Master) have not been 
unselected with the view 
channel option, the actual 
data for the activated 
channel(s) will be displayed 
in the same graph as the 
selected graphic files. By 
clicking the green “Start” 
button, the online 
measurements can be compared directly to the graphics that were saved before. 

The menu option “File -> Display Saved Graph” is preceded by a checkmark as long as the 
earlier saved graphics are displayed. To clear these earlier saved graphics, select again the 
menu option “File -> Display Saved Graph”, after which the checkmark disappears, and only 
the spectra for the active spectrometer channel(s) will be displayed.  

3.1.11 File Menu: Convert Graph – to ASCII 

This option requires that graphic files were saved earlier by using the option “File -> Save 
Experiment”. After choosing this option, a window shows all files in the current measure 
mode. For instance, if the measure mode is “scope”, so the extension of the earlier saved 
spectra is *.roh.  

To select graphic files that were saved in another measure mode, e.g. absorbance, click  
behind the “Graph - …Mode”, and pick the desired measure mode. 

To select graphic files from another folder or drive, click  behind the current folder name. If 
a graphic file is marked by a (single) mouse click on the filename, the comment line for this 
file appears at the top of the graphical region in the main window. Selecting multiple filenames 
can be realized by using the CTRL or SHIFT key in combination with the mouse. 

If the CTRL key is pressed, all the files that are clicked by the mouse will be selected for 
conversion. If the SHIFT key is pressed, all the files in between two clicked files will be 
selected for conversion. 

Select the name of the file(s) to be converted to ASCII and click the “Open” button. To leave 
this dialog without converting files, click the “Cancel” button. The extension of the text files 
depends on the extension of the binary graphic file as shown below: 

 

Extension binary file Extension text-file 
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 ROH    TRT 
 ABS    TAT 
 TRM    TTT 
 IRR    TIT 

All text files start with a header with information for the graphic file that has been converted. 
The header shows: 

o the comment line 
o the integration time 
o the number of scans that has been averaged 
o the number of pixels used for smoothing 
o the serial number of the spectrometer that was used to save the data 

The data in a *.TRT file is given in two columns. The first column gives the wavelength in 
nanometers, the second one the scope data. 

The data in the *.TAT, *.TTT files is presented in five columns. The first column gives the 
wavelength in nanometers. The second to fourth column give respectively the dark, reference 
and scope data. The fifth column shows the calculated value for absorbance (in a *.TAT file) 
or transmittance (in a *.TTT file). 

The format for the irradiance text files (*.TIT) depends on the availability of getSoft-IRRAD. 
The absolute irradiance text file that will be generated if getSoft-IRRAD is available shows six 
columns. The first two columns are the wavelength and dark data. The third column is the 
transfer function from counts to microwatts. The fourth column contains the measured 
counts. In column five and six, the calculated irradiance values are given in microwatts per 
square centimeter (column 5) and in photon counts (column 6). The relative irradiance text file 
that will be generated if getSoft-IRRAD is not available shows five columns. The first column 
gives the wavelength in nanometers. The second to fourth column give respectively the dark, 
reference and scope data. The fifth column shows the calculated value for relative irradiance. 

3.1.12 File Menu: Convert Graph – to ASCII Equi distance 

This option requires that graphic files were saved earlier by using the option “File -> Save 
Experiment”. After selecting the option “File -> Convert 
Graph -> To ASCII - Equi distance” the wavelength 
range for which the data should be converted, and the 
distance between two successive data points can be 
entered in the dialog as shown at the right. After clicking 
the “OK” button, you can select the files which need to 
be converted. Selecting these files is the same as for 
converting to ASCII without the equi distance feature 
(section 3.1.11). 

Also the information in the header file is the same as for converting to ASCII without the equi 
distance feature. The data in the *.TRT, *.TAT, *.TTT and *.TIT files is presented in two 
columns. The first column gives the equally spaced wavelength in nanometers. The second 
column shows the interpolated value for scopedata (in a *.TRT file), absorbance (in a *.TAT 
file), transmittance (in a *.TTT file) or irradiance (in a *.TIT file).  
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3.1.13 File Menu: Convert Graph – to JCAMP 

JCAMP-DX is a standard file format for exchange of spectra between different spectrometer 
systems and computers. A JCAMP-DX spectrum is a text file, which can be viewed, 
corrected and annotated with a text editor. A lot of other elaborate spectrometer software 
programs, like Grams32 and OPUS, are capable of importing files in JCAMP-DX format. 

The JCAMP format requires an equal distance between the data points at the x-axis 
(wavelength). Converting the CCD-pixels to wavelength points is not a linear function, so 
before writing to the JCAMP format, the 2048 (for an getSpec–2048) data points are linearized 
first. 

This option requires that graphic files were saved earlier by using the option “File -> Save 
Experiment”. After choosing this option, a window shows all files in the current measure 
mode. For instance, if the measure mode is “scope”, so the extension of the earlier saved 
spectra is *.roh.  

To select graphic files that were saved in another measure mode, e.g. absorbance, click  
behind the “Graph - …Mode”, and pick the desired measure mode. 

To select graphic files from another folder or drive, click  behind the current folder name. 

If a graphic file is marked by a (single) mouse click on the filename, the comment line for this 
file appears at the top of the graphical region in the main window. Selecting multiple filenames 
can be realized by using the CTRL or SHIFT key in combination with the mouse. If the CTRL 
key is pressed, all the files that are clicked by the mouse will be selected for conversion. If the 
SHIFT key is pressed, all the files in between two clicked files will be selected for conversion. 

Select the name of the file(s) to be converted to JCAMP and click the “Open” button. To leave 
this dialog without converting files, click the “Cancel” button. The text files in JCAMP format 
require an extension DX. If, for example a file gts0001.trm and another file gts0001.abs are 
both converted to JCAMP, the result will be gts0001.dx in both cases. 

3.1.14 File Menu: Exit 

Closes getSoft.  

USB2 

With the USB2 spectrometers, the measurement settings are saved to EEPROM before the 
software is closed. During the process of saving it is very important that the spectrometer is 
not powered off. A dialog as shown at the right will become visible as long as data are saved 
(< 1 sec for USB2), about 8 sec for RS232/Bluetooth connection. 
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…more than spectroscopy! 

3.2 Setup Menu 

 

3.2.1 Setup Menu: Hardware 

USB1 platform 

This menu option displays a list of getSpec spectrometer 
serial numbers that are connected to the PC’s USB port(s) 
and COM port(s) and which are not used by another 
(instance of the) application. This option can be used to 
allocate a spectrometer to an application (for example if one 
spectrometer is running with getSoft-Full and another 
spectrometer needs to run with getSoft-Raman software). 
But it can also be used to run multiple spectrometers 
simultaneously, just by restarting getSoft multiple times.  

After clicking the “OK” button, getSoft will communicate with 
the spectrometer serial number that has been activated in 
the dialog.   

USB2 platform 

 
This option shows all connected spectrometers and allows you to change the name of the 
channel and to deactivate and activate spectrometers. For synchronization of scans a master 
sync spectrometer needs to be dedicated, in Multi-channel platforms usually the 
spectrometer from the left as seen from the front is predestined as master sync by Sentronic. 
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getSpec–3648-USB only 

The Toshiba detector, as implemented in the getSpec–3648, can be used in two different 
control modes: 

1. The Prescan mode (default mode). 

In this mode the Toshiba detector will generate automatically an additional prescan for 
every request from the PC, the first scan contains non-linear data and will be rejected, the 
2nd scan contains linear data and will be showed on the screen and/or saved. This 
prescan mode is default and should be used in most applications, like with averaging (only 
one prescan is generated for a nr of averages), with the use of an getLight-XE (one or 
more flashes per scan) and with multi-channel spectrometers. The advantage of this 
mode is a very stable and linear spectrum. The disadvantage of this mode is that a minor 
(< 5 %) image of the previous scan (ghost spectrum) is included in the signal. 

This mode cannot be used for fast external trigger and accurate timing, since the start of 
the scan is always delayed with the integration time (min. 3.7 ms). 

2. The Clear-Buffer mode. 

In this mode the Toshiba detector buffer will be cleared, before a scan is taken. This clear-
buffer mode should be used when timing is important, like with fast external triggering. 
The advantage of this mode is that a scan will start at the time of an external trigger, the 
disadvantage of this mode is that after clearing the buffer, the detector will have a minor 
threshold, in which small signals (< 500 counts) will not appear and with different 
integration times the detector is not linear. 

3.2.2 Setup Menu: Wavelength Calibration Coefficients 

After clicking this option, a dialog is shown in which the wavelength calibration coefficients 
can be changed manually.  

Background 

The wavelength ?  that corresponds to a pixel number (pixnr) in the detector in the 
spectrometer can be calculated by the following equation: 

4
4

3
3

2
21 pixnrXpixnrXpixnrXpixnrXIntercept ??????????  

in which Intercept and X1 to X4 correspond 
to Intercept and the first to fourth coefficient. 
For example, if we want to calculate the 
wavelength at pixel number 1000, using the 
numbers in the figure at the right, the 
wavelength becomes:  

?  = 384,054 + 0,136492 · 1000 +  
-6,71259E-6 · 1E6 + 
-5,66234E-10 · 1E9 
= 513,267 nm. 
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The “Restore Factory Settings” button restores for all spectrometer channels the original 
wavelength calibration coefficients that were saved to the EEPROM during factory calibration. 

The “Process data only when in following wavelength range” option can be used to transfer 
only a limited number of pixels from the spectrometer to the PC. This can significantly speed 
up the transfer time (e.g. for the getSpec–2048 from 30 ms at full wavelength down to 14 ms 
for a small selection of 10 pixels). A second advantage is data reduction, because only the 
spectral data will be saved at the pixels for which the wavelength is in the specified 
wavelength range.  

3.2.3 Setup Menu: Smoothing and Spline 

The cubic spline interpolation algorithm can be applied to get a better 
estimation for the spectral data between the pixels on the detector 
array. 

Smoothing is a procedure, which averages the spectral data over a 
number of pixels on the detector array. For example, if the smoothing 
parameter is set to 2, the spectral data for all pixels xn on the detector 
array will be averaged with their neighbor pixels xn-2, xn-1, xn+1 and 
xn+2.  

Cubic Spline Interpolation 

In the figure at the right, the effect of spline interpolation is illustrated. The Master data shows 
the AD counts for 4 pixels, connected by a straight line (linear interpolation). The Slave1 data 
is for these 4 pixels exactly the same as for the Master data, but this time the cubic spline 
interpolation algorithm has been applied, resulting in data which is smooth in the first 
derivative and continuous in the second derivative. 

The spline interpolation can be useful for applications in which the output of line sources, like 
laser diodes is displayed, or for other applications, which require a high resolution. Note that 
for the getSpec–2048 with 2048 pixels, the effect of spline interpolation is not visible if the data 
is shown at full scale. The monitor resolution is much less than 2048 pixels. The effect of 
spline interpolation can only be visualized if the number of detector pixels that are displayed is 
smaller than the number of monitor pixels 
at the x-axis. 

Smoothing 

To get a smoother spectrum without 
losing information it is important to set in 
the software the right smoothing 
parameter. The optimal smoothing 
parameter depends on the distance 
between the pixels at the detector array 
and the light beam that enters the 
spectrometer. For the getSpec–2048, the 
distance between the pixels on the CCD-
array is 14 micron. 
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With a 200 micron fiber (no slit installed) connected, the optical pixel resolution is about 14.3 
CCD-pixels. With a smoothing parameter set to 7, each pixel will be averaged with 7 left and 
7 right neighbor pixels. Averaging over 15 pixels with a pitch distance between the CCD pixels 
of 14 micron will cover 15*14 = 210 micron at the CCD array. Using a fiber diameter of 200 
micron means that we will lose resolution when setting the smoothing parameter to 7. 
Theoretically the optimal smoothing parameter is therefore 6. The formula is ((slit size/pixel 
size) – 1)/2. 

In the table at the left below, the recommended smoothing values for the getSpec–2048 
getSpec spectrometer are listed as function of the light beam that enters the spectrometer. 
This light beam is the fiber core diameter, or if a smaller slit has been installed in the 
spectrometer, the slit width. Note that this table shows the optimal smoothing without losing 
resolution. If resolution is not an important issue, a higher smoothing parameter can be set to 
decrease noise against the price of less resolution.   

slit/fiber getSpec-102 
Pixel 77 µm 

getSpec-
256/1024 
Pixel 25 µm 

getSpec-
2048 
Pixel 14 µm 

getSpec-
3648 
Pixel 8 µm 

getSpec-
NIR256 
Pixel 50 µm 

10 µm n.a. n.a. 0 0 n.a. 

25 µm n.a. 0 0-1 1 n.a. 

50 µm 0 0-1 1-2 2-3 0 

100 µm 0-1 1-2 3 5-6 0-1 

200 µm 1 3-4 6-7 12 1-2 

400 µm 2 7-8 13-14 24-25 3-4 

500 µm 3 9-10 17 31 4-5 

600 µm 3-4 11-12 21 37 5-6 

      

3.2.4 Setup Menu: Correct for Dynamic Dark (getSpec-2048/3648 only) 

The pixels of the CCD detector (getSpec-2048/3648) are thermally sensitive, which causes a 
small dark current, even without light exposure. To get an approximation of this dark current, 
the signal of the first 14 optical black pixels of the CCD-detector can be taken and subtracted 
from the raw scope data. This will happen if the correct for dynamic dark option is enabled. As 
these 14 pixels have the same thermal behavior as the active pixels, the correction is 
dynamic.  

Note that this option is different from the dark current that needs to be saved before any 
transmittance or absorbance measurements can be taken (“File -> Save -> Dark”). If the 
correct for dynamic dark option has been changed, it will be necessary to save a new dark 
and reference spectrum because the raw data has been changed. 

If this menu option is preceded by a checkmark, the scope data is corrected with the dynamic 
dark algorithm. It is recommended to leave this setting checked, which is the default state. 
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3.2.5 Setup Menu: Subtract Saved Dark 

This option is used to subtract the dark spectrum that has been saved (“File -> Save -> 
Dark”) from the raw scope data. After starting getSoft, this menu option is always unselected, 
because a dark spectrum needs to be saved or loaded before it can be subtracted. 

If this menu option is preceded by a checkmark, the scope data is corrected with the saved 
dark. 

3.2.6 Setup Menu: Strobe Enable  

This option can be used to enable or disable an external strobe (e.g. the getLight-XE) 
attached to a getSpec-2048 spectrometer. 

The measured light intensity of the getLight-XE is independent of the integration time in 
getSoft. To increase light intensity, the number of pulses per integration interval should be 
increased. The maximum frequency at which the getLight-XE operates is 100 Hz. This 
means that the minimum integration time for 1 pulse per scan is 10 ms. When setting the 
number of pulses e.g. to 3, the minimum integration time becomes 30 ms. It is recommended 
to keep the integration time as low as possible to avoid unnecessary increase of noise. 

USB1 platform 

The getLight-2000 needs to be attached to the getSpec by connecting an IC-DB15-2 interface 
cable to the high density 15 pole Sub-D connectors at the getSpec and getLight -XE. If used 
with an old XE-2000, the XE-2000 has the possibility to switch between Single Flash and Multi 
Flash (in that case there will be a switch at the back side of the XE-2000), make sure that the 
switch is always in the Single Flash position, when using the XE-2000 with an getSpec 
spectrometer (in Single Flash mode the XE-2000 
is triggered at pin 1, in Multi Flash mode at pin 2).  

When clicking the “Strobe Enable” menu option, 
a dialog is shown in which this number of pulses 
can be set. If this menu option is preceded by a 
checkmark, the strobe control function has been 
enabled. To disable the strobe, simply click the 
menu option when preceded by a checkmark. 

Strobe (getLight-XE) Control USB2 platform 

The getLight-XE needs to be attached to getSpec-USB2 by connecting an IC-DB26-2 
interface cable between the high density 26 pole Sub-D connectors at the getSpec-USB2 and 
the 15-pole DB connector of the getLight-XE. If used with a multi-channel system, make sure 
that the getLight-XE is connected to the master sync spectrometer, only the number of 
flashes per scan set for the master synch spectrometer will determine flash rate. To disable 
the strobe, simply enter “0” under the “NrOfFlashes”. 
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3.2.7 Setup Menu: 1 kHz Enable (USB1 platform only) 

Pin 2 of the high density 15 pole Sub-D connector at the 
getSpec-2048 can be used to generate an 1 kHz signal. 
This signal can be used to control an getLight-LED light 
source in pulsed mode. 

3.2.8 Setup Menu: PWM (getLight-LED) control (USB2 
platform) 

The getLight-LED needs to be attached to getSpec-USB2 by connecting an IC-DB26-2 
interface cable between the high density 26 pole Sub-D connectors at the getSpec-USB2 and 
the 15-pole DB connector of the getLight–LED (DO1 – pin11).  

The frequency can be set between 500 Hz and 300 kHz, the duty cycle between 0 and 100 %. 

If used with a multi-channel system, all channels can have their own independent PWM 
setting for both frequency and duty cycle. 

To disable the PWM output, simply enter “0” 
under the “Duty Cycle”. 

3.2.9 Setup Menu: Options 

 
All options described in this section are standard included in getSoft FULL version. In getSoft 
BASIC, these features are not available. 

3.2.9.1 Setup Menu: Options – Check on Saturation 

The 14-bit A/D converter in the getSpec results in raw Scope pixel values between 0 and 
16383 counts. If the value of 16383 counts is measured at one or more pixels, then these 
pixels are called to be saturated or overexposed. Since saturated pixels can disturb the 
measurement results, a lot of attention has been given in getSoft (and the driver package 
as161.dll/AS-5216.DLL) to detect saturation and to notify the user if a measurement contains 
saturated pixels. This notification is done in such a way that the user can always decide to 
ignore the saturation, for example if the saturation happens at pixels that are not in the 
wavelength range where the user is interested in. Saturation can usually be solved by 
selecting a shorter integration time. When at minimum integration the signal is still too high, 
an attenuator, a neutral density filter or fibers with a smaller diameter may be used. 
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In getSoft, different levels of saturation detection can be set, and there are also different 
options for notification, as shown in the figure at the right.  

Saturation detection levels 

The default level of saturation detection is “Detect Saturated Pixels at saturation level”. Only 
for getSpec-2048 spectrometers, the third (auto correct inverted pixels) level is available. The 
reason for this is that if the detector type in the getSpec-2048 (Sony-ILX554) is heavily 
saturated (at a light intensity of approximately 5 times the intensity at which saturation starts), 
it will return values < 16383 counts.  

The other detector types in the getSpec-
102, 256, 1024 and 3648 do not show this 
effect, so no correction is needed. 
Normally, you do not need to use this third 
level for the getSpec-2048, but when 
measuring a peaky spectrum with some 
heavily saturated peaks, the auto correct 
can be used.  

To illustrate this, a strong peak from the 
getLight-CAL calibration line source was 
heavily saturated at 435.84 nm. This 
caused the most heavily saturated pixels 
to return inverted (< 16383 counts) pixel 
values (figure below at the left). In the right 
figure, the saturation detection has been 
set to the third level, which will not only 
detect the saturated pixels at 16383 counts, but also detect and correct the inverted saturated 
pixels. Disadvantage of the auto correct detection level is that processing the saturated scans 
by the application takes more time. 

 

Saturation Notification 

If the saturation detection has not been switched off, the spectrometer channel status bar will 
show the text label “Saturated” as long as one or more pixels of that spectrometer channel 
are saturated: 
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This is useful for measurements in transmittance, absorbance and irradiance mode, because 
in these modes saturation can not be observed by looking at the number of counts, like in 
scope mode. But even in scope mode, a spectrum can contain saturated pixels also when 
this is not directly obvious from the graph. Examples are: 

o Smoothing. The maximum pixel value of a peak can be saturated, but is averaged with 
neighbor pixels which may not be saturated.  

o The correct for dynamic dark algorithm subtracts the dark values that are measured at 
the optical black pixels from the spectral data. Therefore, the saturation level of 16383 
counts will never be reached with correct for dynamic dark ON. The saturation 
detection in getSoft is done before the data is corrected for dynamic dark, so it will 
also detect saturation with dynamic dark ON. 

o Monitor resolution. The CCD contains 2048/3648 pixels which is a lot more than the 
monitor pixels in the graph. Since not each CCD pixels can be drawn at the monitor, a 
sharp peak at one CCD pixel can be saturated although this is not visible at the 
monitor. Use the zoom function if you want to verify if this is the cause of saturation. 

o Zoomed in. Saturation can also happen at a wavelength range that is not visible 
because the graph is not at full scale. 

Under all these circumstances, the “saturation” label will be shown in the status bar of the 
spectrometer channel for which one or more pixels are saturated. During time series 
measurements (History Channel Functions, color versus time, irradiance versus time) the 
saturation detection will be done only for the relevant wavelength range. The relevant 
wavelength range in color measurements is from 380 to 780 nm. For History Channel 
Functions, the relevant wavelength range is set by the user. For example, when monitoring an 
integral between 500 and 505 nm, saturation detection and notification will be done only for 
this range. If saturated, the saturation label will become visible in the History Channel output. If 
the time series measurements are saved online to Excel, the font color in Excel will be red for 
a history channel as long as the output for that channel is saturated. 

USB1 platform only 

Following options are available for USB1 platform spectrometers only; information about the 
saturated wavelength ranges can be visualized and/or saved by enabling the following 
options:  
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Visualize saturated pixels areas in graph 

By enabling this option, the spectrum in the main window will be displayed with a thicker line 
for these wavelength ranges where the saturation occurs. In time series measurements, the 
function output values that were calculated using saturated data are marked with a black dot.  

 
Log saturated pixel areas to screen 

By enabling the second option, a small  window appears in which the spectrometer channel 
number (0 = Master, 1 = Slave1 etc.) and wavelength range for the saturated pixels are given. 

Log saturated pixel areas to file on “Save Measurement” 

The third option can be used to create a file to which the saturated wavelength ranges will be 
written when a measurement is saved in getSoft. When saving spectra in the main window 
(“Save” button, or menu option “File -> Save -> Experiment”), the name of the logfile becomes 
equal to the experimentname, but with the extension *.sat. For example if a graph in 
absorbance mode is saved to test0001.abs and if this spectrum contains saturated data, then 
additional lines will be written to the textfile test.sat.  

If time series measurements, color measurements, irradiance measurements are saved to 
file, the data will also be checked on saturation and if saturation occurs, additional lines will be 
written to a logfile with the same filename as the measurement results, but with the extension 
*.sat (e.g. History.sat).  

The files with extension *.sat can be openend with any textfile editor, for example Notepad. 

3.2.9.2 Setup Menu: Options – Full Width Half Max  

The Full Width Half Maximum of a peak is the 
bandwidth (in nanometers) for which the intensity 
is higher than half of the maximum intensity of that 
peak. The FWHM can be calculated in Scope or 
Irradiance Mode. This utility is used mostly 
measuring the output of laser diodes. During 
FWHM calculations, the intensity needs to be 
corrected for the dark data. Therefore it is recommended to enable the option “Subtract 
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Saved Dark”, as shown in the dialog at the right which appears after clicking the FWHM 
option.  

After clicking the “OK” button, the Full Width Half Max values are calculated for a number of 
peaks. To mark a peak for which the FWHM values need to be calculated, press the ALT key, 
and click with the left mouse button on this peak. If only one spectrometer channel is enabled, 
and there are no earlier saved graphs being displayed, then the FWHM value of the marked 
peak will be shown directly on top of the peak. Furthermore, this peak will be yellow marked 
over the width of the FWHM value (it may be necessary to zoom in on the peak to be able to 
view that the peak is marked). 

If more than one spectrum is being displayed, a dialog, as shown below, pops up in which the 
spectrum for which the FWHM needs to be activated can be selected out of all displayed 
spectra. In the figure below, peaks have been selected for FWHM calculation. The FWHM 
values are given in the same color the spectrum is drawn in.  

 
To disable the FWHM calculation, the menu option (which is marked as long as the FWHM is 
enabled), needs to be reselected. 

3.2.9.3 Setup Menu: Options – Integrals 

This utility can be used for measuring the total amount of energy coming into the 
spectrometer. Up to 10 integrals can be displayed simultaneously. The integral calculations 
are enabled after they have been defined in the dialog that is shown at the right.  

This dialog is displayed after activating the menu option “Setup -> Options -> Integrals”. In the 
example below, two integrals have been defined (the first 2 are marked by the “Enable” 
checkbox in the first column). In the second column, a spectrum can be chosen out of all 
spectra that are at that moment displayed in the main window in getSoft.  
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A full list of the spectra to choose 
from (this includes earlier saved 
spectra like integral 2 in the example) 
is displayed after clicking on the 
arrow button at the right side of the 
second column. In the third and 
fourth column, the wavelength range 
can be entered over which the 
integral should be calculated. Finally, 
a multiplication factor can be entered 
for scaling purpose. After clicking the 
“OK” button, the integral values are 
given as shown in the figure below.  

To disable the integral calculation, 
the menu option (which is marked as 
long as the Integrals are enabled), 
needs to be reselected. 

To measure the integral versus time, up to 8 different functions can be entered in the History 

application. 
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3.2.9.4 Setup Menu: Options – Autosave Spectra Periodically 

With this option complete spectra will be saved automatically in time. The following 
parameters can be set: 

o Time delay before first scan needs 
to be entered in seconds. After 
clicking the “OK” button, getSoft waits 
for this number of seconds, before the 
first scan is saved. 

o Time delay between scans needs to 
be entered in seconds. This defines 
the time between saving two 
subsequent spectra. If this number is 
set to zero, getSoft will save the 
spectra as fast as possible. 

o Number of scans to save: the 
number of spectra that needs to be saved can be entered. 

On top of the parameters that appears at the right, a checkbox shows: Save As Fast As 
Possible (no screen updates). 

If the white checkbox in front of this text line is marked, the Automatic Save option will always 
save the number of scans that have been entered as fast as possible. To do so, the time 
delay between scans is automatically changed to 0 milliseconds at the moment the checkbox 
is clicked. Is this option selected, the spectra will be saved 5 to 10 times faster, compared to 
if this option is not selected. This speed increase has been achieved by mainly two reasons: 

1. During the saving of the number of scans that has been entered, the screen update, 
which is very time-consuming, is not activated. Instead, the main window is temporarily 
minimized, and the number of scans to save is counted down in a new dialog.  

2. No comment files will be generated.  

Other factors that have a positive effect on the speed of the data acquisition, and which can 
be set in getSoft are: 

o Smoothing parameters.  

o Integration time. 

o Averaging. 

o Number of pixels to transfer (section 3.2.2) 

Furthermore, it is recommended to keep the number of files in your experiment directory 
small (a few hundred maximum), because a large number of files in the same experiment 
directory have a negative effect on the system speed. If the automatic saving needs to be 
aborted before all spectra have been saved, the “Autosave Spectra Periodically” menu option 
can be selected again and the value 0 can be entered for the number of spectra to be saved. 
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Save on Digital IN (USB2 platform only) 

For the USB2 platform the DB26 
connector pins 7, 16 and 24 may 
be used to connect external 
switches, such as photo switches, 
to save a spectrum, reference or 
dark. This is specially useful for 
automated sampling in a process 
control environment with periodical 
updates of dark and reference 
signals. It is recommended to 
enable the “Automatic save dark by 
TTL shutter” in combination with 
the “Save on digital In - Dark” 
setting. 

3.2.9.5 Setup Menu: Options – Correct for Drift (USB1 platform only) 

 
Introduction 

When measuring the reflectance of a white reference tile or the transmittance of a reference 
solution against time, the output should theoretically remain 100 % +/- noise. In practice the 
output value will not remain exactly fluctuating round 100 %, but the signal can slowly drift 
away. The cause for this drift in the measurement system can be a change in temperature in 
the optical bench which causes micro bending of the components that focus the light at the 
detector, but also a drift in the light source that is used to illuminate the reference sample.  

To correct for the drift in the system, it needs to be measured first. This can be done with a 2-
channel fiber optic switch (FOS-2-INLINE-UV/VIS) in which case one channel is connected to 
the reference sample and the other channel to the sample that needs to be measured. By 
regularly switching channels (manually or automatically), the measured deviation from 100 % 
at the reference channel can be used to compensate the measured data at the sample 
channel. The same principle can be used if a 2-or multiple-channel spectrometer is available. 
In that case the sample and reference data can be measured simultaneously and the 
measured data at the reference sample can be used directly to correct the sample data. 
Disadvantage of the “Correct For Drift By Spectrometer Channel” is that the data for 
reference and sample are measured by using two optical benches which may react differently 
on temperature changes. If the drift is mainly caused by the light source (such as a difference 
in flash intensity of the XE-2000), this method of correction is recommended. The advantage 
of the “Correct For Drift By FOS-2-INLINE-UV/VIS” is that it will also correct for drift caused by 
temperature changes of the optical bench. Disadvantage is that the correction is sequentially, 
so not every scan is immediately corrected. Moreover, there needs to be time available to 
switch channels. 
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Correct for Drift by FOS-2-INLINE-UV/VIS 

The FOS-2-INLINE-UV/VIS is a 2 channel fiber optic switch. Switching between the optical 
channels can be done manually, or by a TTL signal (see operating manual or FOS-2-INLINE-
UV/VIS hardware manual). By connecting an IC-DB15-2 interface cable between the getSpec-
2048 and FOS-2 (or an IC-DB15-FOS2-2 if a shutter needs to be controlled as well from the 
getSpec-2048), the spectrometer can control the position of the switch. In getSoft, the bottom 
channel has been defined as reference channel, while the top channel should be connected 
to the optical path that is used to measure the samples.  

The Correct for Drift with the FOS-2 can be done in two different ways.  

1. By regularly switching to the FOS reference channel, the measured spectrum can be 
compared to the saved FOS reference spectrum. The differences can be used to correct 
the data that is measured at the FOS sample channel. To be able to correct the sample 
data, the following data needs to be available: 

o Dark spectrum FOS sample channel 

o Dark spectrum FOS reference channel (if integration time at reference channel is 
different from integration time at sample channel) 

o Reference spectrum at FOS reference channel 

2. In Transmittance/Reflectance or Absorbance mode, the measured spectrum at the FOS 
reference channel can be used as a new reference for the FOS sample channel. To be 
able to correct for the difference in sensitivity between both FOS channels, the reference 
material (white tile or blank) needs to be saved at the FOS reference channel as well as at 
the FOS sample channel. This option requires an equal integration time for FOS 
reference and sample channel. The following data needs to be available: 

o Dark spectrum at FOS sample or reference channel 

o Reference spectrum FOS sample channel  

o Reference spectrum at FOS reference channel 

The difference of these two methods of correction is that in the first method there is no 
relation between the data measured at both channels. getSoft uses only the differences 
measured in time at the FOS reference channel to correct the data measured at the sample 
channel. In the second correction method, the correction factor between the both FOS 
channels is determined first, and then the (white) reference measured at the FOS reference 
channel is recalculated and saved as a new reference for the FOS sample channel. 

Since for both methods a dark spectrum needs to be available, save dark before enabling the 
Correct for Drift by FOS-2-INLINE-UV/VIS menu option. After clicking the menu option, the 
following dialog will be shown: 
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If the interface cable between getSpec-2048 and FOS-2 and the Power Supply are properly 
connected, the FOS-2 will close top (= sample) channel and open the bottom (= reference) 
channel. As long as the FOS settings dialog is not closed, the FOS-2 remains in this position.  

If you want to use the second method to correct for drift (by saving a new reference, see 
previous page), click the checkbox “FOS Reference = Sample Reference” at the bottom of 
the dialog. When using the first correction method, the integration time for the FOS reference 
channel can be set to a different value as for the FOS sample channel. Remember to save a 
new dark and reference for the FOS reference channel after changing the integration time. 
Determine a good integration time and save a FOS reference by clicking the white button. 
Then switch off the light source and save a FOS dark spectrum by clicking the black button. 

The FOS correction mode, as shown in the FOS settings dialog can be set to “Software” or to 
“Auto”. This setting determines when getSoft should switch channels during the 
measurements. 

If set to “Software”, the user determines when to switch channels. The left dialog will be 
shown after the “OK” button 
has been clicked in the FOS 
Settings dialog. As long as 
the reference channel is the 
Active FOS Channel, the 
data processing does not 
occur in the main window, 
but a small graph as shown 
in the figure below shows the 
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A/D Counts measured at the FOS-reference channel. When clicking the “Sample channel” 
radio button, the FOS-2 switches channels, and the (corrected) data will be processed as 
usual. A small window will remain visible in which the FOS channel can be switched back to 
the FOS reference channel and measure a new reference spectrum. 

If set to “Auto”, switching of channels will be 
done after a preset number of seconds. 
Furthermore, you can select if you want to 
update the FOS reference spectra once every 
x seconds or only take one sample 
measurement once every x seconds. In figure 
at the right, the sample channel will be measured during most of the 60 seconds. Once every 
60 seconds, the FOS switches to the FOS reference channel to take a new FOS reference 
spectrum that will be used for the correction.  

After clicking “OK” in the FOS Settings dialog, the FOS will display one of the two dialogs 
below. As long as the sample channel is active (left dialog), the measurement results will be 
processed as usual. As long as the reference channel is active (right dialog), the measure-
ment results will be used to update the reference spectrum and the A/D Counts of this 
spectrum will be displayed in the dialog.  

 
Correct for Drift by Spectrometer Channel (USB1 platform only) 

This option is available if the spectrometer system has one or more 
slave channels. One spectrometer channel will be used as a reference 
channel, which will continuously measure the reference spectrum (e.g. 
the white tile in reflectance measurements or the cuvette holding the 
reference solution in transmittance measurements). Changes in this 
reference signal, e.g. because of drift in the light source, will be used to 
correct the data of the other (selected) spectrometer channels. The 
wavelength range over which the data can be corrected will be the 
overlapping wavelength range between reference spectrometer 
channel and the spectrometer channel to be corrected. 

If this option is activated, a dialog is shown in which the reference 
channel and one or more (depending on the number of spectrometer 
channels that are available) channels to be corrected can be selected. 
After selecting the right setup, and clicking the “OK” button, getSoft 
shows the right information. 

Turn on your light source, choose the right integration time and save reference. Then turn off 
the light source and save dark. After clicking “OK”, getSoft enables the spectrometer 
channels that are relevant in the correct for drift application. After saving the reference and 
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dark files, a message dialog shows that the data will be corrected for drift. The menu option 
will be preceded by a checkmark. To disable the correct for drift option, the menu option (if 
preceded by a checkmark) needs to be clicked. 

3.2.9.6 Setup Menu: Options – Automatic Save Dark by TTL shutter 

To use the automatic save dark option, an interface cable needs to be connected from the 
spectrometer to the light source with shutter (getLight-HAL-S, getLight-DHc, getLight-D(H)-S-
(DUV) ). The interface cable between TTL-shutter and spectrometer is for the USB1 platform 
a 15 to 15 pin cable (IC-DB15-2) and for the USB2 platform a 26 pin to 15 pin cable (IC-DB26-
2).  

The TTL switch at the light source needs to be in TTL-position. In getSoft, the menu option 
“Save automatic dark by TTL Shutter” needs to be enabled in the menu “Setup -> Options”. If 
this option is enabled, the TTL will close the shutter of the light source at the moment the dark 
data is saved. After the dark has been saved, the shutter will be opened automatically. 

3.2.9.7 Setup Menu: Options – External Trigger Setting 

USB1 platform 

The DB15 connector on the getSpec–2048 spectrometer uses two pins for digital IN 
communication: pin 4 and 8. 

Pin 4 is used for the Hardware Trigger mode and pin 8 is a regular digital in which status can 
be polled. In getSoft, two 
functions have been 
defined for using the 
digital in at pin 8. A lot 
more (customer specific) 
features can be easily 
implemented. For 
generating a +5V signal at 
pin 8 manually, the 
handheld pushbutton 
cable IC-Extrig-2 may be 
ordered, or if the 
“Automatic Save Dark by TTL shutter” option needs to be supported as well, an “IC-DB15-
Extrig-2” Y-cable can be ordered. The different options, which are shown in the dialog above, 
are described below. 

Perform scans continuously, save first available spectrum if TTL signal is high (pin 8) 

In this mode, getSoft will poll the status of pin 8 after each arriving scan. If the status of pin 8 
is HIGH (+5V), the spectrum (or spectra in case more spectrometer channels are active) will 
be saved automatically, as described in section “3.1.7 File Menu: Save Experiment”. 

A comment dialog will not be shown, instead the spectrometer channel number and a time 
stamp will be written to the comment file. Note that the spectrum will be saved only if the 
signal is high at the moment of polling, which is the moment that getSoft receives a new 
spectrum from the data acquisition driver. If a short TTL pulse is generated at pin 8, there is a 
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big chance that the spectrum is not saved. To save one spectrum, the duration of the TTL 
signal should therefore be as long as the product of integration time and number of scans to 
average. In time critical situations, it is recommended to use the External Hardware Trigger 
Mode. 

Perform scans continuously, save first available spectrum as Reference if TTL signal 
is high (pin 8) 

For absorbance or reflectance/transmittance measurements, it is recommended to update 
the reference data regularly, to exclude effects like drift in the light source or e.g. temperature 
effects of the detector or in the optical bench. In most cases, reference is saved manually by 
clicking the white “Reference” button. This reference data will be saved automatically if this 
external trigger option is selected and the status of pin 8 is HIGH (+5V) at the moment that a 
new spectrum is available. For the required TTL signal duration and timing, see the above 
description for saving spectra at high TTL signal. 

External Hardware Trigger, perform a single scan at rising edge of TTL pulse (pin 4) 

By selecting the external hardware trigger option, the data acquisition mode of the 
spectrometer is changed. There will be no data acquisition until a TTL pulse is received at pin 
4 of the DB15 connector. The delay between the rising edge of the TTL pulse and the start of 
the integration time cycle depends on the spectrometer type, as shown in the table below. 

Spectrometer Type Minimum Delay [? s] Maximum Delay [? s] 

getSpec–102 1000 1500 

getSpec–2048 (S/N = 0405054S1) 2000 2500 

getSpec–2048 (S/N > 0405054S1) 1.26 1.30 

getSpec–2048FT 1.26 1.30 

For example, the integration time (as set in getSoft) starts for a standard getSpec–102 after 
1.0 to 1.5 ms after receiving the TTL pulse at pin 4 of the DB15 connector. After the 
integration time expires, the data is processed by getSoft and the spectrometer waits for a 
next pulse. The external hardware trigger is useful to observe short pulse events (i.e. laser 
pulses). To measure a laser pulse, the getSpec–2048FT includes an option to send out a 
TTL-pulse at pin DO2 to fire the laser just before the integration time cycle starts (delay = -42 
ns). By setting the delay between the TTL-out at DO2 and the start of the integration time to a 
positive value, the getSpec–2048FT can be used in LIBS application (Laser-induced 
breakdown spectroscopy), where the laser pulse itself should not be measured, but the 
plasma emission e.g. 1 ?s after firing the laser. For details about the delay settings for the 
getSpec–2048FT in external hardware trigger mode, see below. 

If the white “Automatic Save On Trigger” box is marked, each spectrum that will be recorded 
in external hardware trigger mode will be saved automatically. 

Make sure that, before the External Hardware Trigger is selected and confirmed by the 
clicking the “OK” button, a +5V TTL pulse can be set on pin 4. To leave the external trigger 
mode, the “Setup -> Options -> External Trigger Setting” menu option needs to be selected, 



 

 
info@getSpec.com 

 
Tel. : +49 (0) 351 871 8423   Tél. : +33 (0) 4 72 80 82 02   Tel. : +49 (0) 231 974 2285   
Fax : +49 (0) 351 871 8465   Fax : +33 (0) 4 72 80 82 43   Fax : +49 (0) 231 974 2286 
             
    

• Dresden • Lyon • Dortmund • Sofia 
Seite 45 

 

 

…more than spectroscopy! 

and the “None” radio button needs to be clicked, followed by the “OK” button. However, the 
spectrometer firmware will not return to normal acquisition mode before it receives the TTL 
pulse at pin 4. 

getSpec–2048FT and external hardware trigger 

The getSpec–2048FT has been developed for the LIBS (Laser-Induced Breakdown 
Spectroscopy) applications, but can of course also be used in applications that need a fast 
response to an external trigger signal, such as when measuring products at a conveying belt. 

If the getSpec–2048FT scanning is controlled by an external hardware trigger signal at pin 4 of 
the DB15 connector, it will carry out the following events after receiving this trigger signal: 

1. First it will respond by putting a TTL output signal at pin 2 of the DB15 connector. This 
TTL output can be used to fire the laser in the LIBS application. 

2. The integration time cycle starts an user defined delay after the TTL output to the laser 
has been given. The minimum period for this delay  is -42 nanoseconds, in which case 
the laser pulse itself will be measured because the integration time will start 42 ns before 
the TTL-out at DO2. The setting of the delay period can be increased with 42 
nanoseconds steps. The maximum delay is 2730583 ns. A frequently used delay setting 
in LIBS applications is 1000 ns. There is no jitter on the delay period, which makes to 
getSpec–2048FT not only suitable for simple classification, but also for precise 
quantitative analytical applications. 

The software programmable delay between the output at DO2 (to fire the laser) and the start 
of the integration time is used to avoid the measurement of the first period directly after the 
laser pulse, in which the plasma emission shows a high intensity, but without the useful 
information. The figure below shows an example of the plasma emission intensity after the 
laser pulse. The integration time for the getSpec-2048FT can be set from 2 ms to 60000 ms. 
In LIBS applications, the minimum integration time of 2 ms is used. 

Programmable delay: -42 ns to +2730583 ns in 42 ns steps, jitter = 0 ns 
This portion of the plasma emission is not included in the integration time 



 

 
info@getSpec.com 

 
Tel. : +49 (0) 351 871 8423   Tél. : +33 (0) 4 72 80 82 02   Tel. : +49 (0) 231 974 2285   
Fax : +49 (0) 351 871 8465   Fax : +33 (0) 4 72 80 82 43   Fax : +49 (0) 231 974 2286 
             
    

• Dresden • Lyon • Dortmund • Sofia 
Seite 46 

 

 

…more than spectroscopy! 

To set the delay in getSoft, select the external hardware trigger option in the External Trigger 
Setting dialog, as shown in the 
figure. Enter the delay (in 
nanoseconds) between the 
output that will be given at pin 2 to 
fire the laser and the start of the 
integration time cycle. If you want 
the spectra to be saved 
automatically, enable the 
“Automatically save on Hardware 
Trigger” option. Then click “OK”.  

When measuring in external 
hardware mode, the data acquisition is controlled by the external trigger pulse input. 
Therefore, the “Start/Stop” button will be disabled. The edit bar will show the current setting 
for the delay (1000 ns in the figure below).  

As long as the spectrometer is in this mode, you cannot send commands from getSoft to the 
spectrometer. So if you need to change the delay, you will first need to disable the external 
trigger mode. This can be done in the external trigger mode dialog, by selecting the “None” 
button, but a shortcut with the same effect is to click the “Trigger Checkbox” in the edit bar of 
the main window. Note that one more trigger pulse is needed before the external trigger mode 
is disabled. The reason for this is that the spectrometer can only react on an external trigger 
at pin 4 before it can respond to the “Disable External Trigger Mode” command. 

After disabling External Trigger mode and providing one more trigger, an edit box will show up 
with the current delay setting (see figure below). The delay setting can be changed in this edit 
box (-42 to 2730583 nanoseconds) 

After changing the delay, you can enable the external hardware trigger by clicking the Trigger 
checkbox. 

Note that the resolution of the delay in nanoseconds is steps of 41.67 ns, with an offset of     -
41.67 ns. So if you enter e.g. a delay of 800 ns, the software will calculate the closest step (= 
-41.67+20*41.67 = 792 ns).  

For the spectra that are saved in external hardware trigger mode, a comment file will be 
created automatically, in which the date, time and delay are shown. This may help to 
compare the spectra that were recorded with different delay settings to determine an optimal 

Trigger Checkbox 
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delay (“File -> Display Saved Graph”). The optimal delay period depends on the material and 
the laser in the LIBS application. 

External Trigger setting USB2 platform 

If the external trigger is enabled the spectrometer will wait until a TTL signal at pin 6 of the 
DB26 connector gets high and will then start the integration time. The delay between the 
rising edge of the TTL pulse and the start of the integration time cycle depends on the 
spectrometer type, as shown in the table below. 

Spectrometer Type Minimum Delay [? s] Maximum Delay [? s] 

getSpec–102-USB2 9 60 

getSpec–256-USB2 0,80 0,84 

getSpec–1024-USB2 0,80 0,84 

getSpec–2048-USB2 1.28 1.30 

getSpec–3648-USB2 1.28 1.30 

getSpec–NIR-256 0 600 

NrOfScans 

If a number of scans is set to a value higher than 1, the spectrometer will accumulate multiple 
scans on every rising edge of the external TTL trigger. This setting is overruled when “Level 
Triggered” is enabled. 

Save Spectrum 

If this box is checked, the scans that the spectrometer will accumulate will be saved to the 
hard disk. If “NrOfScans > 1” the data saving will be done as fast as possible without screen 
updates. 

Edge Triggered 

When this mode is selected one or multiple scans will be started at the rising edge of a TTL 
pulse at pin 6 of the DB26 connector. The delay between the rising edge and the actual start 
of the integration time can be found in the table above. 
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Level Triggered 

When this mode is selected the spectrometer will start to accumulate data (take scans at the 
selected integration time) at the rising edge of the TTL pulse and will continue to do so as long 
as the TTL signal remains high. When the signal becomes low, the average of the 
accumulated data (except for the last scan) will be displayed or saved. This mode is specially 
useful for conveyor belt applications, when a product needs to be scanned, independent of 
the transport speed. 

3.2.9.8 Setup Menu: Options – Auto configure Integration time 

After this menu option is clicked, getSoft starts searching for an optimal integration time. 
Depending on the maximum counts in the last scan, the integration time will be increased/ 
decreased automatically until an optimal signal is measured. 

The changing values of the actual integration time during the search can be followed in the 
integration time field at the edit bar. If the auto configure integration time routine needs to be 
aborted before an optimal integration time has been found, click the “?AC” button (which is in 
the down position during the search), or reselect the menu option “Setup -> Options -> Auto 
Configure Integration time”. 

When the maximum peak is around 14000 counts, a dialog is shown in which the new 
integration time is given. Since the integration time has changed, new reference and dark 
spectra need to be saved, before switching to transmittance or absorbance mode is possible. 
For this reason this option is only available in scope mode.  

3.2.9.9 Setup Menu: Options – Use Custom Reflection Reference 

In Transmittance/Reflectance Mode, the transmittance/reflectance at pixel n is calculated 
using the current sample, reference and dark data sets in the following equation: 

Cn is the Custom Reflectance 
Reference factor at pixel n. In 
earlier versions of getSoft, 
this factor was set to 100 for 
each pixel and could not be 
modified. In getSoft version 6, 
the custom reflectance 
reference factor is default set 
to 100, but can be set to 
different values if needed. If 
the reflectance spectrum of a 
“white” calibration tile is 
known, the data can be read 
from a file, or entered in a 
table in getSoft. The resulting 
custom reference data can 

??
?

?
??
?

?
?

?
?

nn

nn
nn darkref

darksample
CT *



 

 
info@getSpec.com 

 
Tel. : +49 (0) 351 871 8423   Tél. : +33 (0) 4 72 80 82 02   Tel. : +49 (0) 231 974 2285   
Fax : +49 (0) 351 871 8465   Fax : +33 (0) 4 72 80 82 43   Fax : +49 (0) 231 974 2286 
             
    

• Dresden • Lyon • Dortmund • Sofia 
Seite 49 

 

 

…more than spectroscopy! 

be saved and loaded under a user defined filename. 

Click the “Enable Custom Standard” radio button, and then “OK” in the Custom Reflectance 
Settings dialog to use the customized reference data in getSoft.  

The status of this option is shown in the button bar by the addition of a green border to the 
white button. If the border is absent, 100 % reflectance will be assumed for the reference tile. 
If the border is present, like in the figure above, customized reflectance values will be used for 
all calculations. 

3.2.9.10 Setup Menu: Options – Suppress Save Comments 

This option, if preceded by a checkmark, disables the appearance of the comments dialog 
box if an experiment is saved as described in section “3.1.7 File Menu: Save 
Experiment”.  

By default this option is OFF. After clicking the menu option it will be enabled (preceded by a 
checkmark). 

3.2.9.11 Setup Menu: Options – View Reflectance instead of Transmittance 

Although mathematically equivalent, the experimental setup for a measurement in reflectance 
or transmittance mode is different, and therefore the possibility to select the name 
“Reflectance” instead of “Transmittance” is implemented. By default the option is not 
preceded by a checkmark, meaning the program will use Transmittance mode. By clicking 
the menu option, a checkmark will appear and the program will use the name “Reflectance” 
instead of “Transmittance”. The effect of the change is twofold:  

o In Reflectance/Transmittance mode, the Reflectance name will shown at the y-axis 

o The caption at the “Reflectance/Transmittance” button will change from T to R, and 
the corresponding menu option under View will change from “Transmittance mode” to 
“Reflectance mode”. 
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3.3 View Menu  

 
3.3.1 View Menu: Scope Mode 

The display is set to Scope Mode, showing a real time raw data signal, with on the y-axes the 
read out of the AD-converter and on the x-axes the calculated wavelength. 

3.3.2 View Menu: Absorbance Mode 

In Absorbance Mode, the absorbance at pixel n is calculated using the current sample, 
reference and dark data sets in the following equation: 

3.3.3 View Menu: Transmittance/Reflectance Mode 

In Transmittance Mode, the transmittance at pixel n is calculated using the current sample, 
reference and dark data sets in the following equation: 

As described in section “3.2.9.9 Setup Menu: Options – Use Custom Reflection Reference” 
the reference (white) percentage of 100 can be customized. The percentage of transmittance 
is mathematically equivalent to the percentage of reflectance and can also be used for 
reflectance experiments (see also section “3.2.9.11 Setup Menu: Options – View Reflectance 
instead of Transmittance”). 

3.3.4 View Menu: Irradiance Mode 

If the Absolute Irradiance Measurements Module has been ordered with getSoft, this option 
will show the absolute energy output in µWatt/cm2/nm. An elaborate description about the 
experimental setup in case of absolute irradiance can be found in section “4.4. Application: 
Absolute Irradiance ”. 
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If the absolute irradiance application is not available, a light source of known color 
temperature is needed as a reference, for example the getLight-HAL with color temperatures 
of 2850 K at default jumper setting. The relative radiance energy at wavelength ?  is then 
calculated using the current sample, the reference and the dark data sets: 

Where B? is the computed component of the spectral distribution of the blackbody radiant 
emittance (at user selected temperature in degrees Kelvin), divided by the current reference 
data at wavelength ?  

How to take relative irradiance measurements with getSoft 

1. Start the getSoft software, and click the “Start” button in the main window. 

2. Connect a fiber to the spectrometer input port. 

3. Adjust the smoothing parameters in the setup menu to optimize smoothing for the used 
fiber/slit diameter. 

4. Set up the experiment so that the other end of the fiber points at the sample of light to 
be determined (use a fixture for the best results). Usually some sort of spectrum can be 
seen on the screen, but it is possible that too much or too few light reaches the 
spectrometer at the present data collection settings.  

 Too much light means that, over a certain wavelength range, the signal is overloaded 
shown as a straight line at any arbitrary height, even near zero. This can usually be 
solved by a shorter integration time. The integration time can be changed in the main 
window, in the white box below the “Start/Stop” button.  

 If getSoft is collecting data, the “Start/Stop” button shows a red “Stop” and the 
integration time box is gray, indicating that it cannot be changed. After clicking the “Stop” 
button the data acquisition stops and the integration time can be changed.  

 The result of the changed integration time can be viewed after clicking the green “Start” 
button. Try to adjust the integration time, such that the maximum count over the 
wavelength range is around 14000 counts. When at minimum integration the signal is 
still too high, fibers with a smaller diameter can be used. When not enough light 
reaches the spectrometer, likewise a longer integration time should be entered. 

5. When a good spectrum is displayed, turn off the light source. 

6. Now save the dark data. This is done by “File -> Save -> Dark” from the menu or by 
clicking the “Save Dark” button. 

7. Turn on the reference light source of known color temperature (2850 K for getLight-HAL 
with default jumper setting) and set up the fiber end that is not connected to the 
spectrometer, so that a good spectrum is displayed on the screen.  

Note that the integration time or fiber type may not be changed while measuring the 
reference data. If there is too much light, adjust the focusing of the light source, so less 
light is coupled into the fiber. As long as only light from the reference light source and no 
ambient light is coupled into the fiber, this will not influence the spectral distribution, only 

? ????? darksampleBS ?? *
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its height. Try to set up the fiber such that the maximum count over the wavelength 
range is around 14000 counts. 

8. Save the reference data. This is done by “File -> Save -> Reference” from the menu or 
by clicking the “Save Reference” button. 

9. Note that the whole operation of saving a reference file does not need to be carried out 
each time a new experiment is started. The reference data are saved in a file called 
ref*.dat and can be loaded next time by choosing the option “File -> Load -> Reference” 
.  

After saving or loading reference and dark the irradiance mode can be chosen by 
clicking the “I” button or by the menu option “View -> Irradiance Mode”. First a message 
box appears in which the value of the color temperature in Kelvin of the light source that 
has been used as a reference can be entered. If light from the reference light source is 
viewed, the Planck-curve for the color temperature of the reference light source is 
displayed. The maximum of the reference Planck-curve has been set to 100. 

3.3.5 View Menu: Channel (only for USB1 platform) 

After selecting this option, a dialog is shown in which the channels to be 
displayed can be selected. Depending on the number of available channels in 
the spectrometer system that is used, up to 8 spectrometer channels can be 
selected. If displaying graphs that were saved before (“File -> Display Saved 
Graph”), the active channels also remain visible, to be able to measure online 
against a saved graph background. To view only the saved graphs, all active 
channels need to be unselected. 

3.3.6 View Menu: Change Graph Scale 

After selecting this option, a dialog is shown in which the 
range for both x- and y-axis can be changed. To switch to 
the full scale, the “View -> Graphic Reset” option, or the 
mouse zoom-out feature can be used. By clicking the 
“Save” button in this dialog, the settings for x-axis and y-
axis will be saved to a file and can be restored in the 
future by selecting the menu option “View -> Goto Preset 
Scale” or by clicking the “Goto Preset Scale” button in the 
button bar. 

3.3.7 View Menu: Graphic Reset 

When selecting this option, the graph will be reset to the default x- and y-axes. 

3.3.8 View Menu: Autoscale y-axis 

By using this option, the graph will be rescaled on-line. A maximum signal will be shown at 
about 75 % of the vertical scale.  
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3.3.9 View Menu: Goto Preset Scale 

By clicking this menu option, the scale for x- and y-axis will be set to a range that has been 
set before. The same result can be achieved by clicking the “Goto Preset Scale” button in the 
button bar. 

3.3.10 View Menu: Grid Enable 

When the “Grid Enable” option is activated, a grid will be displayed in the graph as shown in 
the figure below.  

 

3.3.11 View Menu: Progress Bar Enable 

If using long integration times or a high number of averages, it can take a few or more 
seconds before a new scan is received by the application. To get an indication about how 
much time it will take until the next scan arrives, a progress bar can be displayed.  

After enabling the progress bar by clicking the menu option, it will be displayed after the next 
scan has arrived. The progress bar will be shown only if the time between scans is more than 
one second. The time between scans is roughly the integration time, multiplied with the 
number of averages. However, if the number of averages is high, the time between scans can 
get longer because of the overhead time that is spent on transmitting the high number of 
average spectra to the PC.  
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4 Applications 

 

4.1 Application: History Channel Functions  

4.1.1  History Application: Function Entry 

With the History 
Application, the output of 
self defined functions or 
integrals can be followed 
in a graph against time. 
Up to 8 functions can be 
followed simultaneously.  

The functions are defined 
in the dialog at the right, 
which is shown after the 
menu option “Application 
-> History -> Function 
Entry” has been chosen. 

The functions F1 to F8 
can be selected by 
clicking the 
corresponding TAB sheet 
at the top of this dialog. 

Furthermore, a number 
of general (function 
independent) parameters 
can be entered, below of the function TAB sheets.   

Function Type 

The first time that the Function Entry dialog is activated, all 8 functions are not activated 
(Function Type = None). To define a function, the “Function Type” radio button needs to be 
changed from None to Integral, User Defined, View Spectrum or Peak. After defining the 
Function Type, the Measure Mode, Function Definition and Function Display Settings can be 
set. 
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Measure Mode 

The four possible modes (Scope, Absorbance, Transmittance or Irradiance) are described in 
section 3.3.1 to 3.3.4. Note that if the selected measure mode is Absorbance, Transmittance 
or Irradiance a reference and dark spectrum needs to be saved or loaded before the History 
Channel Measurements can be started. 

Function Definition 

The parameters that need to be entered in the function definition box depend on the function 
type that has been chosen: Integral, User Defined, View Spectrum or Peak.   

Function Definition - Integral 

 
In case a function is defined to display the integral versus time, the following parameters can 
be set: 

Spectrometer Channel. The default is Master, but in case more channels are available, this 
can be changed to Slave1, Slave2 … up to Slave7.  

The “From” and “To” edit boxes may be changed to specify the wavelength range in 
nanometer over which the integral needs to be calculated.  

Finally, a multiplication factor can be entered. The value entered here is multiplied with the 
calculated integral.  

Function Definition - User Defined 

 
If you want to display the output of a self defined function against time, a function needs to be 
defined first. You can either enter an user defined input function in the dialog box, or assign a 
script to the history channel. 

Input Functions 

A comprehensive example of an input function is given in the dialog, but it illustrates only a 
few of the functions getSoft can handle. A list of allowed operators and functions is given 
below: 
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Operators: *,  /, +, - 

Functions: log(x) = natural log 
log10(x) = log base 10 
exp(x) = e to the power of x 
sqrt(x) = square root 

Additionally, the wavelength signal for master and slave channel(s) can be entered by: 

m(wavelength in nm) = master 
s1(wavelength in nm) = slave1, s2(wavelength in nm) = slave2, etc. 

For example: the function that needs to be entered to follow the intensity of the HG peak 
against time at the second slave channel is: s2(253.65) 

Scripts 

A scripting feature has been added to allow you to use more complicated calculations with 
many more mathematical and logical functions. Scripts will also allow you to combine the 
results of several history channels. 

getSoft uses the Microsoft VBScript language that comes with your copy of Windows. We 
have included a help file for VBScript for your reference. You can reach it from the main menu 
by selecting “Help -> VBScripts“. It lists among other things all available operators and 
functions. 

When you edit a script, either the previous script for the channel will be shown, or a new 
starter script will be generated if there is no previous script. GetSoft includes a simple script 
editor. The scripts are plain ASCII files, named Fx_script.txt, where x is the history channel 
number, from 1 to 8. 

A starter script has the following contents: 

Function F2(value) 
 F2=0 
End Function 

You can elaborate on this function, as long as there is a value assigned to F2 in the end. In 
this case, F2 will be assigned the value 0. 

You can refer to the other history channels with the predefined variables F1 to F8. If you want 
to use data from the spectrometer, you will need to assign other history channels to e.g. 
wavelength values or integrals. The following script defines the function value for F3 as the 
quotient of F1 and F2. 

Function F3(value) 
 F3=F1/F2 
End Function 

Please do not refer to the function value for the script itself. You can also not refer to other 
functions, if these are themselves assigned to a script. This will result in a scripting run-time 
error. If you want to use code from another script, please copy the necessary lines from that 
script into the one your working with. 
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Please understand that a script is executed by an interpreter, on a line by line basis. If you 
make a syntax error in your script, it will usually only show at the moment the line with the 
error is executed, as a run-time error. 

Nothing will stop you, for instance, from entering the following script for function 3: 

Function F3(value) 
 F3=F1/0 
End Function 

Running this script will 
result in the run-time error 
at the right: 

 

If you refer to channels that are undefined (Function Type „None“), they will be handled as 
uninitialized variables by VBScript, with value 0. This is the case for all uninitialized variables 
you might use in your scripts. 

Finally, a small example to monitor the integral of a peak between 522 nm and 550 nm, in 
which an offset is subtracted. The offset area is the area below of the straight line between 
the output at 522 nm and the output at 550 nm.  

F1 is defined as a user defined input function: m(522) 
F2 is defined as a user defined input function: m(550)  
F3 is defined as the zero-based integral between 522 nm and 550 nm. 

The script for function F4 can then be written as: 

Function F4(value) 
 If F1 > F2 Then 
  offset = 28*(F2 + (0.5*(F1-F2))) 
 Else 
  offset = 28*(F1 + (0.5*(F2-F1))) 
 End If 
 F4 = F3 - offset 
End Function 

Function Definition - View Spectrum 

 
 
The View Spectrum function does not display function output against time. Instead, the 
wavelength range that has been entered in the function definition box will be displayed at the 
x-axis. The spectrum for the selected spectrometer channel will be displayed in the selected 
measure mode. In combination with getSoft-XLS, the View Spectrum mode can also be used 
to export the spectra online to Excel (section 4.6) 
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If the History Channel Functions are used to track the intensity or wavelength of a peak (see 
below for the Function Definition – Peak), a graphical feature can be used to visualize the 
peak changes in a spectrum. The number of peaks to display in the spectrum can be entered. 
This number (between 0 and 100) is the number of vertical lines that will be drawn in the 
spectrum, each vertical line representing one of the detected peaks in the past. 

o The height of the vertical line is equal to the peak intensity. 

o The wavelength at which the vertical line is drawn in the spectrum corresponds to the 
wavelength of the detected peak. 

o The color of a vertical line represents the oldness of the peak: Most recent peak is red, 
going back in time followed by orange, green and blue. All older peaks are gray 
colored, from light gray (oldest peak) to dark gray (one peak older than blue).   

The time interval at which the vertical lines are updated is the same as the time interval at 
which the function output is saved (to be entered under “Save every x Seconds” under “Save 
Function Output”). 

For example, suppose the function output will be saved every 3 seconds, and the number of 
peaks to display has been set to 10 in function F1. After starting the history channel 
measurements, the peak in the spectrum drawn for F1, will be marked by a red vertical line 
immediately. In the next 3 seconds, the spectral peak may vary in height or position but the 
red vertical line remains at the same place and height. After 3 seconds, the red vertical line 
becomes orange, and a new red line will be drawn at the position and with the height of the 
peak detected at that moment (t = 3). After 6 seconds another line is drawn and the colors are 
shifted again, so that red is most recent, then orange, then green. At t = 27 seconds, the 10th 
vertical line is drawn, again red for the most recent, the oldest is now represented by a light 
gray color. At t = 30 seconds, the oldest peak is removed from the list (since in this example 
the Nr of peaks to display is 10), a new one is added and the colors are shifted according to 
the definition etc. 

Function Definition - Peak 

 
In case a function is defined to display a peak versus time, the following parameters can be 
set: 

The Spectrometer Channel: The default is “Master”, but in case more channels are available, 
this can be changed to Slave1, Slave2 up to Slave7.  

The “From” and “To” edit boxes may be changed to specify the wavelength range in 
nanometer, which will be evaluated in the peak search. Finally, a selection can be made to 
define the Peak Output: Wavelength or Intensity.  

If both wavelength and intensity need to be followed against time, one of the functions (F1 … 
F8) can be used to follow the peak wavelength, and another function to follow the peak 
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intensity. To visualize the peak changes, a third function can be set to “View Spectrum” with 
e.g. the wavelength range set to 455 - 457 as well and the nr of peaks to display set to 10. In 
the figure above, the resulting output will be the wavelength of the highest peak between 455 
and 457 nanometer. If the intensity button had been selected, the function output would have 
been the intensity of the highest peak between 455 and 457 nanometer. 

Function Display Setting  

 
 
For Integral, User Defined and Peak functions, the output can be displayed graphically against 
time. The amount of time that will be displayed at the x-axis can be set manually by clicking 
the “Fixed” radio button. If set to “Auto”, the time axis will be set to 1 minute. This option is not 
available if the View Spectrum Function Type has been selected, because the x-axis range is 
in that case in nanometers, and determined by the wavelength range as described above. 

The y-axis can also be set to “Fixed” or to “Auto”. The auto option will set the y-axis range to 
the minimum and maximum function values that are in the list of measured data points.  

Function Independent Parameters 

 
Function Independent Parameters - Display no graphics to speed up data processing 

Below the TAB sheets for function definition an option can be enabled or disabled to speed up 
data processing by not displaying the graphics during the measurements. If an application 
requires fast data processing (e.g. more than 10 scans per second), this option should be 
enabled. If saved to an output file, the data can be displayed graphically after the time series 
experiment has been ended, as described in section “4.1.3 History Application: Display Saved 
History Graph”. 

Function Independent Parameters - Save Function Output 

The results of a time series experiment will be saved to an ASCII-file if the radio button “Save 
Function Output” has been selected. A number of seconds between saving can be entered 
for data reduction, in case measurements are carried out over long periods. Entering a value 
of zero results in saving every scan. The name of the file to which the data will be saved, can 
be changed after clicking the “Change Output File …” button. Last option in the “Save 
Function Output” box is to enable or disable the possibility to create a backup file during the 
measurements. If this option is enabled, getSoft will create a backup file with the same 
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filename, but with the extension *.bak (also in ASCII). This backup file is updated every scan 
and can be used in case the filename that has been selected has failed to save the data, for 
instance because of a power failure during the measurements. 

Save HCF…/Load HCF buttons 

getSoft automatically saves all parameters (function definition, save options) to the file hcf.ini, 
and restores these parameters, the next time getSoft is started. With the “Save HCF…” and 
“Load HCF…” buttons, it is also possible to save these parameter settings to (and load from) 
a file with the extension *.hcf. With this feature it is possible to save for each experiment a 
different HCF file, so it can be loaded a next time the same settings are required. The left 
figure below shows the dialog in which the name of the hcf file can be entered after clicking 
the “Save HCF…” button. The right figure below, which is displayed after clicking the “Load 
HCF…” button, illustrates how to select an earlier saved HCF file.   

 
 

After the definition of one or more functions, the “OK” button is clicked to confirm, the 
“Cancel” button to leave the dialog without changes. If the “OK” button is clicked, getSoft 
performs a number of checks on the data that has been entered. If no warnings show up, the 
parameters that have been entered are accepted, and the measurement can be started by 
the “Application -> History –> Start Measuring” menu option. 

4.1.2  History Application: Start Measuring 

This option displays the output against time for the history functions that have been defined in 
the History Channel Function Entry dialog box. If the option “Display no graphics to speed up 
data processing” has been marked in the function entry dialog, the function output will be 
shown by numbers only, which are updated each time a new scan is saved to the output file.  

There are six buttons at the top of this window: an “Exit” button, a “Pause/Start” button, a 
“Save Reference” button, a “Save Dark” button, an “Info” button and a “Print” button.  

If the red “Exit” button is clicked, the time measurements are ended and the main window and 
menu is activated again. The yellow “Pause “button can be used to stop the time 
measurements temporarily. After clicking the “Pause” button, data acquisition stops and the 
text on the button changes to a green “Start”. If the “Start” button is clicked, data acquisition is 
activated again and the text changes back to the yellow “Pause” again. 
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The “Save 
Reference” and 
“Save Dark” buttons 
have the same 
functionality as in the 
main window.  

The “Info” button 
shows the Function 
Entry dialog, in which 
all parameters can 
be viewed  (not 
edited) while the 
measurement is 
running. 

By clicking the “Print” 
button, the graphics 
that are displayed 
can be printed during 
the run. First the 
printer specific dialog 
shows up in which the print options can be set. For example, if only one graph of the four in 
the figure above need to be printed, this graph can be selected by the page(s) radio button. All 
graphics are printed full size on a different page. 

Zoom features 

In each graph the same zoom features apply as in the main window (except for scaling the y-
axis with the mouse wheel). However, zooming in over the x-axis while the measurement is 
running and the x-axis is already scrolling will not be possible, because in that case the x-axis 
is updated with each new scan. Clicking the “Pause” button to take a snapshot will solve this 
problem. 

Zoom in: Select a region to be expanded to the full graph. To select this region, click the left 
mouse button in the white graphics region and drag it downwards and to the right. After 
releasing the left mouse button, both the x- and y-axis will be rescaled to the new values of 
the selected region. 

Zoom out: Drag with the left mouse button within the white graphics region, but in stead of 
dragging the mouse downwards and to the right, drag it into another direction. After releasing 
the mouse button, both the x- and y-axis will be reset to their default values. 

Move X-Y: Dragging with the right mouse button results in moving the complete spectrum up 
or down and to the left or right. 
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4.1.3 History Application: Display Saved History Graph 

If time measurement data have been saved, 
the resulting ASCII-file can be displayed 
graphically by selecting this file in the dialog 
that is shown after clicking the “Display 
Saved History Graph” menu option. 

After clicking the “Open” button, the function 
output of the functions with function type 
“Integral” or “User Defined” is displayed 
against time. Both x- and y-axis are set to 
their full scale, which is determined by the 
minimum and maximum values in the list. 

 
The zoom features, as described in section “4.1.2  History Application: Start Measuring”, 
can be applied, to zoom in on an interesting time interval. A description for the “Print” button 
can also be found in section 4.1.2. 

Since the History Channels Output file is in ASCII, this file can be easily imported in a 
spreadsheet program like Microsoft Excel. The data in the file can also be viewed with a text 
editor, like Microsoft Word, or with Notepad. An example of the file format is given on the next 
page.
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History Channel Functions Measurement Report 

Measurements started at 29/06/01   Time: 15:06:29 

Integration time: 3 ms 

Average         : 1 scans 

Description of the Functions: 

FUNCTION 1: User Defined Function: m(400). Scope Mode. 

FUNCTION 2: User Defined Function: m(500). Absorbance Mode. 

FUNCTION 3: User Defined Function: m(600). Transmittance Mode. 

FUNCTION 4: User Defined Function: m(700). Irradiance Mode. 

FUNCTION 5: Integral Master Channel, between 380,0 and 780,0 nm. Multiplied with: 1,000. 
Transmittance Mode. 

FUNCTION 6: View Spectrum in Transmittance Mode.  No Data Saved  

FUNCTION 7:Not Activated 

FUNCTION 8:Not Activated 

Time Seconds F1 F2  F3 F4 F5         

15:06:29 0,62  79,79 -2,294E-3 100,8 74,11 40192      

15:06:30 0,77  81,84 -2,059E-3 100,9 74,17 40236      

15:06:30 0,92  81,79 -3,756E-3 100,2 73,77 40201      

15:06:30 1,07  84,69 -3,209E-3 101,0 73,43 40202      

15:06:30 1,22  82,19 -7,877E-4 100,3 74,11 40188 

4.2 Application: Wavelength Calibration  

Please refer to section “3.2.2 Setup Menu: Wavelength Calibration Coefficients” for a 
description about the polynomial that converts the pixel number on the detector into the 
corresponding wavelength at the x-axis in getSoft.  

If a Mercury-Argon light source (getLight-CAL) is available, together with suitable optical fibers, 
an automatic wavelength calibration can be performed. The recommended optical fibers used 
for auto calibration are: 

GS-SMA-IR-008-2 8 µm core, Vis/NIR, 2 meters long, SMA 
GS-SMA-IR-050-2 50 µm core, Vis/NIR, 2 meters long, SMA 
GS-SMA-UV-050-2 50 µm core, UV/Vis, 2 meters long, SMA 

An important precondition for a successful auto calibration is the absence of saturation. The 
easiest way to assure this is to select the “Check on Saturation” option (section “3.2.9.1 
Setup Menu: Options – Check on Saturation”). If the spectrometer is saturated at minimum 
integration time, a fiber with smaller core diameter (e.g. GS-SMA-IR-008-2) needs to be used. 
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As an alternative, the incoming light can be attenuated e.g. by using an attenuator (FOA-Inline) 
or neutral density filter. 

4.2.1 Wavelength Calibration: Perform New Calibration 

The procedure to perform an auto calibration is as follows: 

1. Connect the fiber to the getLight-
CAL light source and to the 
spectrometer channel to be 
calibrated. 

2. Choose a suitable integration time 
so as not to saturate the detector. 
The peaks can be seen in scope 
mode. 

3. Select the menu option “Application 
-> Wavelength Calibration -> 
Perform New Calibration”.  

4. The auto calibration routine will now 
search for a number of peaks; 
initially it will look for 5 peaks in the 
data from the master channel. 

5. The spectrometer channel and the 
number of peaks to look for can be 
altered. A new search can be 
performed by pressing the “Find Peaks” button. The peaks are shown in 3 columns. The 
first column shows the position of the peaks found. The second column shows the 
position of a suggested standard peak, if available. The last column lists the difference 
between the first two columns. You can edit the values of the second column by selecting 
them with the mouse.  

6. Select the polynomial order. In most cases a third order polynomial will show an excellent 
fit (see figure above) 

7. The “include 2nd order peaks” option can be enabled if 
second or third order peaks should be added to the list 
of available literature peaks (e.g. 507.30 nm as second 
order peak for 253.65). In most spectrometers, the 
second order effects are eliminated by filters or 
coatings, but if these options have not been added to 
the spectrometer, and second order peaks are 
available, then these can be included in the calibration. 
The central column cells will be marked green if a 
second order peak is found and yellow if a third order 
peak is found. 

8. Press the “Calculate” button. If your calibration is 
successful, you will be asked to confirm new 
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coefficients. Select “OK” and the new calibration will be applied immediately. 

9. At least 3 peaks are needed to successfully complete a new calibration. Try to calibrate 
with more peaks. Selecting too many peaks can however lead to peaks that cannot 
matched with standard wavelengths. 

4.2.2 Wavelength Calibration: Restore Original Calibration 

This option enables the user to restore the calibration coefficients to their original values, i.e. 
the values that getSoft was shipped with. If a new calibration was performed with a limited 
number of peaks, or over a limited wavelength range, the results could be less favorable. 

This option allows the user to undo unwanted changes to the calibration.  

4.3 Application: Color Measurement  

 

 
The getSoft Color Application has been developed to perform on-line color measurements 
with a spectrometer system. It can be used for reflective color measurements, in earlier 
versions of getSoft called “Color Of Object Measurements”. The CIE 1976 L*a*b* color 
parameters are calculated, as well as other frequently used parameters, like Hue, Chroma 
and X, Y, Z. 

These parameters can be displayed in a CIELAB chart or in a graph versus time. It is also 
possible to save the measured L*a*b* values online to a database and use one of the 
products from the database as a reference color. By comparing the measured L*a*b* values 
to the stored database values, color differences (? ELab, ? L*, ? a*, or ? b*) can be measured 
as well.  

Emissive color measurements can be done to measure the color of a light source (e.g. 
LED’s). These measurements require an irradiance spectrum to calculate the color 
parameters x, y and z. With getSoft’s Irradiance application, it is possible to perform 
irradiance measurements with a lot higher accuracy than when using the relative irradiance 
mode (which assumes a perfect blackbody light source with known color temperature). For 
this reason the emissive color or “color of light” calculation is one of the features in the 
irradiance application. 
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4.3.1 Color of an Object – Background  

The color of an object can be expressed by the CIE 1976 (L*a*b*) color space. L* describes 
the lightness of the color. A positive value of a* describes the redness of the color, a negative 
a* the greenness. Similarly, yellowness or blueness is expressed by coordinate b*, which is 
positive for yellow and negative for blue. The L*a*b* values are derived from the CIE 
tristimulus values X, Y and Z of the sample (object) and the standard illuminant tristimulus 
values Xn, Yn and Zn. 

The standard illuminant tristimulus values for Xn, Yn, and Zn are constant and depend only on 
the type of standard illuminant that has been chosen. 

The CIE tristimulus values X, Y and Z of the color of an object are obtained by multiplying the 
relative power P of a standard illuminant, the reflectance R (or the transmittance) of the 
object, and the CIE standard observer functions x?, y? and z? (2 degrees or 10 degrees angle). 
The integral of these products over all the wavelengths in the visible spectrum (380 to 780 nm 
with a 5 nm interval) gives the tristimulus values. 

The chromaticity coordinates x, y and z are obtained by taking the ratios of the tristimulus 
values (X, Y and Z) to their sum: 

 

 

 

Another well known way to present the color parameters a* and b* is by their hue angle (h*) 
and Chroma (C*). 

Hue angle is measured in degrees starting with h*=0 in the red direction (+a*) and increasing 
counterclockwise: 

*

*
* arctan

a
b

h ?
 

Chroma is defined as the length of the line from the point a*=b*=0 to the sample point: 
22 *** baC ??  

To describe color differences, a well known parameter is ? EL ab, which is defined as: 

222 *)(*)(*)( baLELab ???????  

In which, ? L*, ? a* and ? b* represent the difference in L*a*b* values between the reference 
color and the actual measured L*a*b* values. 

4.3.2 Color Measurement  

After selecting the menu option “Application -> Color Measurement” a dialog is displayed in 
which the input parameters can be set. The dialog shows two tabbed pages: one is called 
“LABChart” and shows the input parameters for displaying the color measurements in a color 
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chart; the other one is called “Time Series” and shows all input parameters for displaying up 
to eight color parameters in a graph versus time. The input parameters will be described in 
detail in sections “4.3.2.1 LABChart” and “4.3.2.2 Time Series”. 

The color measurements are started by clicking the “OK” button. getSoft returns to the main 
window if the “Cancel” button is clicked. 

4.3.2.1 LABChart 

  
The color measurements in the LABChart are started by clicking the “OK”. The following 
parameters can be set before the measurements are started: 

o Spectrometer Channel. If the spectrometer system contains one or more slave 
spectrometer channels, the spectrometer channel on which the color will be 
measured can be selected from the drop down box at the upper left corner (showing 
by default “Master”). Make sure white reference and dark spectra have been saved 
before for the selected spectrometer channel. 

o Illuminant. The CIE Standard sources A, B or C or one of the illuminants D50, D55, 
D65 or D75 can be selected by clicking one of the radio buttons. The default is D65, 
which is the most widely used illuminant. It represents the power distribution of 
average daylight, with a correlated color temperature of 6500 K. The D50, D55 and 
D75 have correlated color temperatures of 5000 K, 5500 K and 7500 K. The CIE 
Standard sources A, B or C represent respectively: Incandescent light (2854 K 
blackbody), Simulated noon sunlight and Simulated overcast sky daylight. Note that 
there is no relation between the illuminant chosen here and the light source that is 
used for measuring the color of an object. The selected illuminant is used in 
calculation of the color parameters. These color parameters will be different if for 
example A will be selected instead of D65, just as the color of an object will look 
different in average daylight or in incandescent light (2854 K blackbody). 
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o CIE Standard Observer. The original CIE standard observer functions x?, y? and z? 
were defined in 1931, and are known as the 2 degrees standard observer values. The 
2 degrees corresponds with the angle of vision that was used in the experiments to 
determine these standard observer values. In 1964, the CIE recommended the use of 
different observer values for a higher correlation with visual perception for large 
samples. These are known as the 1964 supplementary standard observer, or 
10 degrees observer values. Both standards are still in use, and in getSoft, the CIE 
standard observer can be selected by clicking one of the radio buttons. The default is 
2 degrees.  

o Display settings. The measurement results can be displayed graphically in 3 charts: 

1. the LABChart in which a* and b* are shown by a moving dot in a CIELAB graph 

2. the Measured Color Panel, which displays the color which is being measured. 
Note that the displayed color on the monitor may not match exactly the color of 
the object (depends on monitor), but it will give a good impression. 

3. The Reference Color Panel, which displays the reference color that has been 
selected under the “reference color” setting.  

The graphical display can be enabled or disabled by a mouse click for each graph separately. 

o Display following Color Parameters. The values of the color parameters that are 
enabled will be displayed below of the charts during the measurements  

o Save Settings. The color parameters can be saved to an ASCII file during the 
measurements. The current name and location of this ASCII file is shown under save 
setting. This filename (and path) can be changed by clicking the “Change Output File” 
button. The next dialog will be displayed: 

To start a new file for saving the color 
parameters, enter a filename that does not 
already exists (getSoft will add the .txt 
extension), and click “Open”.  

If an existing file is selected, the color 
parameters that will be saved are appended to 
this file. This way experiments that were saved 
before can be proceeded, using the same 
output file. 

o Reference Color 

 
The reference color can be set to compare the L*, a* and b* color parameters during the 
online measurements with the LREF, aREF and bREF of the reference color. The color 
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differences can be shown during the measurements by dL (= L* - LREF), da (= a* - aREF), 
db (= b* - bREF) and/or dE (= ? (dL2 + da2 + db2)). 

The reference color can be entered manually under “Current Reference Color” in the figure 
above, or it can be selected from a database file. The database file is a list of reference colors 
that were saved before to this file, all with a unique ProductID. By default the name of the 
database file is “empty.pct”. By clicking the “DB” button, a different database file can be 
selected, or a new file can be created. 

To start a new database file for saving 
reference colors, enter a filename that does 
not already exists (getSoft will add the .pct 
extension), and click “Open”.  

To open an existing file simply double click 
on the filename, or select it and click the 
“Open” button. The file example.pct can be 
found in getSoft’s main directory (default 
C:\getSpec60) and contains a few 
measured reference colors. 

To select a reference color from the database file, click the select button, below of the “DB” 
button. The contents of the database file will be displayed as shown in the figure below: 

To select one of the products from the list, click on one of the numbers (1 … 11) in the first 
(gray) column.  

To delete a product from the list, select it and click the delete key on the keyboard. 

To search for a certain productID or number, click the “Find” button. 

To sort the records by ProductID, L-
REF, a-REF or b-REF, click on the 
corresponding column header. A yellow 
marked „1“ will be shown in the column 
header. By clicking again at the header 
which is already marked, the sorting 
direction will be converted.  

By clicking the “Cancel” button, the 
selected product will not be moved to 
the current reference color in the 
LABChart settings dialog, and changes 
(e.g. deleting a product from the list) will 
be ignored. 

By clicking the “OK” button, the current 
reference color in the LABChart settings 
dialog is changed to the color which has 
been selected. 

To add the current reference color 
(specified in the LABChart settings 
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dialog) to the database file, the “Add” button (below of the select button) can be clicked. If the 
ProductID already exists, a dialog will be shown in which the choice can be made to overwrite 
the old color parameters with the new ones, or to keep the old values for this productID. As an 
alternative, a reference color can be added to the database during the online measurements. 
This can be done only if in the LABChart settings dialog, the option “Add new reference colors 
to DB when measuring” is enabled. 

After all settings are filled in correctly the 
measurements can be started by clicking 
the “OK” button, or using the Enter key on 
the keyboard. A shortcut to start measuring 
with LABChart directly (omitting the settings 
dialog) is clicking the “LABChart” button in 
getSoft’s main window. 

The figure at the right shows all color 
parameters and all 3 charts were enabled. 
The measurements in the figure are 
performed with the Master spectrometer 
channel and illuminant D65 has been 
selected. The color parameters are calculated with the 2 degrees CIE standard observer 
values. The filename to which data will be saved can be found in the lower left corner. 

The button bar in the LABChart shows the following buttons: 

o The “Exit” button is clicked to stop the color measurements and return to getSoft’s 
main window. 

o The “Save Reference” and “Dark” buttons have the same functionality as in getSoft’s 
main window. 

o The “Save as reference color” button is used to update the current reference color. 
After clicking this button, a dialog is 
displayed in which a name for the 
ProductID needs to be entered. If the 
productID already exists in the 
database file and if the option “Add 
new reference colors to DB when 
measuring” is enabled in the 
LABChart settings dialog, then a 
dialog will be shown in which the 
choice can be made to overwrite the 
old color parameters with the new 
ones, or to keep the old values for 
this productID (see right figure). 

o The “Select” button can be used to select a new reference color from the database, 
as described in detail on the previous page.  

o Each time the “Save” button is clicked, a new record is added to the Filename in the 
lower left corner.  One record contains the following fields: Date, Time, Comments, L, 
a, b, h, c, X, Y, Z, RefProductID, Lref, aRef, bRef, dL, da, db, dE, Channel, Illuminant 
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and Observer. The Comments field contains the text that is entered in the dialog that 
is shown after clicking the “Save” button. 

4.3.2.2 Time Series 

 
With time series color measurements, up to 8 color parameters or color differences can be 
followed simultaneously in a graph against time. The time series settings are defined in the 
dialog above, which is shown after clicking the Time Series TAB page. The functions F1 to F8 
can be selected by clicking the corresponding TAB sheet at the top of this dialog. 

Furthermore, a number of general (function independent) parameters can be entered, below 
of the function TAB sheets. The following features can be set separately for all functions F1 to 
F8:  

o Spectrometer Channel. If the spectrometer system contains one or more slave 
spectrometer channels, the spectrometer channel on which the color will be 
measured can be selected from the drop down box at the upper left corner (showing 
by default “Master”). Make sure white reference and dark spectra have been saved 
before for the selected spectrometer channel.   

o Illuminant. The CIE Standard sources A, B or C or one of the illuminants D50, D55, 
D65 or D75 can be selected by clicking one of the radio buttons. The default is D65, 
which is the most widely used illuminant. It represents the power distribution of 
average daylight, with a correlated color temperature of 6500 K. The D50, D55 and 
D75 have correlated color temperatures of 5000 K, 5500 K and 7500 K. The CIE 
Standard sources A, B or C represent respectively: Incandescent light (2854 K 
blackbody), Simulated noon sunlight and Simulated overcast sky daylight. Note that 
there is no relation between the illuminant chosen here and the light source that is 
used for measuring the color of an object. The selected illuminant is used in 
calculation of the color parameters. These color parameters will be different if for 
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example A will be selected instead of D65, just as the color of an object will look 
different in average daylight or in incandescent light (2854 K blackbody). 

o CIE Standard Observer. The original CIE standard observer functions x?, y? and z? 
were defined in 1931, and are known as the 2 degrees standard observer values. The 
2 degrees corresponds with the angle of vision that was used in the experiments to 
determine these standard observer values. In 1964, the CIE recommended the use of 
different observer values for a higher correlation with visual perception for large 
samples. These are known as the 1964 supplementary standard observer, or 
10 degrees observer values. Both standards are still in use, and in getSoft, the CIE 
standard observer can be selected by clicking one of the radio buttons. The default is 
2 degrees.  

o Function display settings. For each function, one of the color parameters can be 
selected. Functions for which the color parameter has been set to “None” will be 
disabled. If one of the color difference parameters (dL, da, db or dE) is selected, the 
reference color to which the measured color needs to be compared needs to be 
defined as well. Therefore the reference color definition box (figure below) will be 
displayed if dL, da, db or dE is clicked. 

 
For each function, a different reference color can be selected. A detailed description 
about the “DB”, “Select” and “Add” buttons can be found in the previous section. 

The color parameters that have been set in the functions can be displayed graphically 
against time. The amount of time that will be displayed at the x-axis can be set 
manually by clicking the “Fixed” radio button (see figure below). If set to Auto, the time 
axis will be set to 1 minute. The y-axis can also be set to “Fixed” or to “Auto”. The Auto 
option will set the y-axis range to the minimum and maximum function values that are 
in the list of measured data points.   
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Function Independent Parameters 

 

Function Independent Parameters – Display no graphics to speed up data processing 

Below the TAB sheets for function definition an option can be enabled or disabled to speed up 
data processing by not displaying the graphics during the measurements. If an application 
requires fast data processing, this option should be enabled. If saved to an output file, the data 
can be displayed graphically after the time series experiment has been ended, as described 
in section “4.1.3 History Application: Display Saved History Graph”. 

Function Independent Parameters – Save Function Output 

The results of a time series color experiment will be saved to an ASCII-file if the radio button 
“Save Function Output” has been selected. A number of seconds between saving can be 
entered for data reduction, in case measurements are carried out over long periods. Entering 
a value of zero results in saving every scan. The name of the file to which the data will be 
saved, can be changed after clicking the “Change Output File …” button. Last option in the 
“Save Function Output” box is to enable or disable the possibility to create a backup file during 
the measurements. If this option is enabled, getSoft will create a backup file with the same 
filename, but with the extension *.bak (also in ASCII). This backup file is updated every scan 
and can be used in case the filename that has been selected has failed to save the data, for 
instance because of a power failure during the measurements.  

Save Setting/Load Settings buttons 

GetSoft automatically saves all parameters (color parameters, save options) to the file 
cootime.ini, and restores these parameters, the next time getSoft is started. With the “Save 
Settings” and “Load Settings” buttons, it is also possible to save these parameter settings to 
(and load from) a file with the extension *.coo. With this feature it is possible to save for each 
experiment a different *.coo file, so it can be loaded a next time the same settings are 
required. The left figure below shows the dialog in which the name of the file can be entered 
after clicking the “Save Settings” button. The right figure below, which is displayed after 
clicking the “Load Settings” button, illustrates how to select an earlier saved *.coo file. 
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After the definition of one or more functions, the “OK” button is clicked to start measuring, the 
“Cancel” button to leave the dialog and return to getSoft’s main window.  

After starting the color measurements by clicking “OK”, the output of the selected color 
parameters will be displayed against time. If the option “Display no graphics to speed up data 
processing” has been marked in the function entry dialog, the function output will be shown by 
numbers only, which are updated each time a new scan is saved to the output file.  

There are six buttons at the top of this window (see figure below): an “Exit” button, a 
“Pause/Start” button, a “Save Reference” button, a “Save Dark” button, an “Info” button and a 
“Print” button.  

If the red “Exit” button is clicked, 
the time measurements are 
ended and the main window 
and menu is activated.  

The yellow “Pause” button can 
be used to stop the time 
measurements temporarily. 
After clicking the “Pause” 
button, data acquisition stops 
and the text on the button 
changes to a green “Start”. If 
the “Start” button is clicked, 
data acquisition is activated 
again and the text changes 
back to the yellow “Pause” 
again. 

The “Save Reference” and “Save Dark” buttons have the same functionality as in the main 
window.  

The “Info” button shows the dialog, in which all parameters can be viewed (not edited) while 
the measurement is running. 

By clicking the “Print” button, the graphics that are displayed can be printed during the run. 
First the printer specific dialog shows up in which the print options can be set. For example, if 
only one graph of the four in the figure above need to be printed, this graph can be selected by 
the page(s) radio button. All graphics are printed full size on a different page. 
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At the right top of each graph, a color indicator panel shows the color of the sample being 
measured. If the function output is a color difference value, like dE in the figure above, then a 
second color indicator panel is shown for the reference color. 

If time measurement data have been saved, the resulting ASCII file can be displayed 
graphically by selecting this file in the dialog that is shown after clicking the menu option: 
“Application -> History -> Display Saved History Graph”.  

After clicking the “Open” button in this dialog, the function output is displayed against time. 
Both x- and y-axis are set to their full scale, which is determined by the minimum and 
maximum values in the list. 

Zoom features 

In each graph the same zoom features apply as in the main window (except for scaling the y-
axis with the mouse wheel). However, zooming in over the x-axis while the measurement is 
running and the x-axis is already scrolling will not be possible, because in that case the x-axis 
is updated with each new scan. Clicking the “Pause” button to take a snapshot will solve this 
problem. 

Zoom in: Select a region to be expanded to the full graph. To select this region, click the left 
mouse button in the white graphics region and drag it downwards and to the right. After 
releasing the left mouse button, both the x- and y-axis will be rescaled to the new values of 
the selected region. 

Zoom out: Drag with the left mouse button within the white graphics region, but in stead of 
dragging the mouse downwards and to the right, drag it into another direction. After releasing 
the mouse button, both the x- and y-axis will be reset to their default values. 

Move X-Y: Dragging with the right mouse button results in moving the complete spectrum up 
or down and to the left or right. 
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4.4 Application: Absolute Irradiance Measurement 

 
getSoft-IRRAD has been developed to perform on-line absolute irradiance measurements 
with an getspec.com’s spectrometer system. A calibrated light source - getLight-HAL-CAL or 
getLight-DH-CAL - with known energy output (in µWatt/cm2/nm) is used as a reference. Also 
the calibration of an getSpec.com’s spectrometer system can be done in the calibration lab, 
after which this calibration can be loaded.  

Color of light parameters can be expressed by the chromaticity coordinated x, y and z. These 
chromaticity coordinates are obtained by taking the ratios of the tristimulus values (X, Y and Z) 
to their sum. The tristimulus values X, Y and Z and the spectral irradiance are computed in a 
wavelength range from 380 nm to 780 nm, using a 1 nm interval. These parameters, as well 
as the coordinates u, v and the color temperature of an external light source can be 
calculated and displayed in real-time. For LED measurements, the dominant wavelength and 
purity are interesting parameters, which can be calculated as well.  

The same experimental set up (spectrometer with fiber optics and cosine corrector or 
integrating sphere) is used to calculate the photometric and/or radiometric parameters of the 
light to be measured. The calculated output can be displayed and saved in three ways: 

o In the main window the data can be displayed as spectral irradiance in µWatt/cm2/nm 
versus wavelength. 

o The measurement results can also be displayed in an irradiance chart (figure above), 
which shows the chromaticity diagram, the irradiance spectrum, the spectrum in 
scope mode and many parameters for colorimetry, photometry, radiometry and peak 
measurements. Up to 10 different radiometric parameters and/or wavelength ranges 
can be selected for which the output will be displayed. 
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o In Time Measurement mode, up to 8 functions can be displayed simultaneously 
against time. For each function, a different radiometric, photometric, color coordinate 
or peak output parameter and/or wavelength range may be selected, as well as a 
different spectrometer channel. 

4.4.1  Background 

Before irradiance measurements can be done, an intensity calibration is required. The 
intensity calibration contains the data transfer function for each pixel. The data transfer 
function is used to convert the scope data (A/D Counts) into irradiance data (in µWatt/cm2) . 
To be able to calculate the transfer function, a calibrated light source, with known output (in 
µWatt/cm2/nm) needs to be available. 

When saving the A/D Counts with the reference light source on and off, we know the relation 
between the A/D Counts and µWatt/cm2: 

??
?

?
??
?

?
? nn

n

darkcalrefcal
Caldata

 

Caldatan = Intensity of the calibrated light source at pixel n (in  µWatt/cm2) from lampfile 
refcaln  = A/D Counts at pixel n that were saved with the reference light source on 
darkcaln = A/D Counts at pixel n that were saved with the reference light source off 

??
?

?
??
?

?
?

?
?

nn

nn
nn darkcalrefcal

darksample
CaldataI *  

When measuring the A/D counts received from a light source different from the calibrated 
light source (but of course with the same fiber optic cable and diffuser), this relation can be 
used to measure the intensity at every pixel n (in µWatt/cm2). If samplen is the measured 
A/D counts at pixel n when looking at the sample light source, and darkn is the measured 
A/D counts with the sample light source off, then the equation for intensity In (in µWatt/cm2) 
becomes: 

If during the intensity calibration a different integration time was used (e.g. 100 ms) from the 
integration time during the sample measurements (e.g. 2 ms), a factor needs to be added to 
the equation to compensate for this. In the example the factor is 100/2 = 50.  

Calculating the intensity (in µWatt/cm2) from the measured sample spectrum (in A/D Counts) 
can therefore be done by the following equation: 

factor
darkcalrefcal

darksample
CaldataI

nn

nn
nn ** ??

?

?
??
?

?
?

?
?  

From the irradiance spectrum (in µWatt/cm2), a lot of light output parameters can be 
calculated: colorimetric, photometric and radiometric.  

Below, short background information is given about the colorimetric, radiometric and 
photometric parameters. We also describe the definition of the peak parameters that can be 
measured as well.  
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Colorimetry 

The color of light can be expressed by the chromaticity coordinates x, y and z. These 
chromaticity coordinates are obtained by taking the ratios of the tristimulus values (X, Y and Z) 
to their sum: 

 

The tristimulus values X, Y and Z are computed by: 

 

where: 

k  = constant (= 1/(? y? ) = 0.00934 
I?   = Spectral irradiance at wavelength ?  
x? , y? , z?  = CIE 1931 or 1964 Standard Observer value (2 or 10 degrees angle) at 

wavelength ?  

The tristimulus values X, Y and Z and the spectral irradiance are computed in a wavelength 
range from 380 nm to 780 nm, using a 1 nm interval. 

The CIE1960 UCS color coordinates u and v are calculated by:  

 

The equation that is used for calculating the color temperature is empirical and assumes a 
black body radiator: 
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In LED measurements, the Dominant Wavelength and Purity (also known as Helmholtz 
coordinates) are often used to describe a color. The Dominant Wavelength can be calculated 
for a measured sample point S with chromaticity coordinates (Sx, Sy) by drawing a straight 
line from the midpoint in the chromaticity diagram (E with x = y = 0.333) through S towards 
the edge of the Chromaticity Diagram (spectrum locus). The points at the spectrum locus 
correspond with a wavelength and the interception of the straight line through E and S with the 
locus is called the Dominant Wavelength. 
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Purity, is the distance from the midpoint (E) to the sample point (S), divided by that from the 
midpoint (E) to the spectrum locus (DW): 

DWE
SE

Purity
?

?
?  

The method described above is used for all colors with a Dominant Wavelength from 380 to 
699 nanometer. If the x, y coordinates are in the triangle area encompassed by the 3 points E, 
A and B, then the Dominant Wavelength can not be calculated because the interception point  
through E and S with the spectrum locus (between A and B) does not correspond with a 
wavelength. In that case the Complementary Dominant Wavelength (CDW) is used. The line 
from E through S is extended backward in order to determine the Complementary Dominant 
Wavelength (CDW).  
 

 
Peak Measurements 

A typical spectral power distribution of a (green) LED is shown in the figure at the right. A 
number of peak parameters can be calculated from this spectrum: 

FWHM and Center Wavelength 

The Full Width Half Maximum of a peak is the bandwidth (in 
nanometers) for which the intensity is higher than half of the 
maximum intensity of that peak. The Center Wavelength is the 
wavelength halfway between the left and right wavelength where the 
intensity is half of the maximum intensity. 

Peak Wavelength 

Wavelength at the maximum spectral power 

Centroid Wavelength 

The total spectral power left and right from the centroid wavelength (integral) is the same. 

E 

S 
DW 

A 

B 
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Radiometry 

The radiometric parameters can be grouped into three categories: 

o Radiant Flux [µWatt]: The radiant flux is the total optical power emitted from a source 
in all directions. The best way to measure the power emitted by a source is to 
measure the source inside an integrating sphere. This is often done when measuring 
LED’s. It is also possible to calculate the flux of a source by measuring the irradiance 
at the surface of the diffuser (cosine corrector or integrating sphere sample port) at a 
certain distance from a light source. An important assumption in this calculation is that 
the source should be isotropic and the distance between diffuser and source should 
be greater than five times the largest dimension of the source (approximation of point 
source). 

o Radiant Intensity [µWatt/sr]: The radiant intensity is the optical power per unit solid 
angle. It is used to quantify the optical power that is emitted by a source into a certain 
direction. Radiant intensity is calculated from the measured irradiance by 
multiplication with the square of the distance between source and diffuser surface. It is 
assumed that the source is a point source. 

o Irradiance [µWatt/cm2]: Irradiance is used to measure the power that is received by a 
surface. 

Radiometric measurement can be done in different setups, like with fiber optic cosine 
corrector or integrating sphere. Both setups can be used to measure the irradiance spectrum 
received at the surface of the diffuser (cosine corrector or integrating sphere sample port) at 
a certain distance from a light source. When measuring at a certain distance from the 
source, the radiant intensity and flux can be calculated as described above. When measuring 
a light source inside an integrating sphere, the radiant flux can be measured, but radiant 
intensity and irradiance parameters cannot be measured. 

Radiometric parameters calculated from the power distribution 

The power distribution can be easily converted in an energy distribution by multiplying the 
power with the integration time. The result is the amount of energy that has been emitted or 
received during one integration time cycle.  

Another radiometric parameter that can be calculated from the irradiance spectrum, is the 
number of photons that is received by a surface. Since the number of photons per 
nanometer is a huge number (even with very low light intensity), the number of Avogadro is 
used to express the number of photons in mols, or as in our application in µmols. The number 
of photons per nanometer can be calculated from the wavelength dependent photon energy, 
and the absolute light energy that is measured. A detailed description how this is done can be 
found at the next page. 

The photon count distribution [µmol/(s.m2.nm)] shows the photon flux received per square 
meter. Other photon count units that can be calculated from this are: 

o [µmol/(s.nm)] photon flux received at diffuser surface 

o [µmol/(m2.nm)] photons received per square meter during one integration cycle 

o [µmol/nm] photons received at diffuser surface during one integration cycle 
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In the table below, the radiometric parameters that can be measured in getSoft are listed. 
Note that a wavelength range needs to be specified over which the parameter spectral output 
will be integrated. In the first column (Hardware Setup) “inside sphere” refers to 
measurements that are done with the light source inside an integrating sphere, while “outside 
sphere or cc” refers to measurements that are done with a light source at a certain distance 
from the sphere or with a cosine corrector. 

 

How to convert a power distribution [µWatt/(cm2.nm)] into a photon count 
distribution [µMol/(s.m2.nm)] 

Photon energy E(?) = h.c/? e 
 
Where: 
h = Planck´s constant 6,626 068 76 x10-34 
c = velocity of light 2,998 x108  m/s 
? = wavelength in meters 
 
For example, the photon energy at 250 nm and at 1000 nm is: 
E(250) = (6,626 x 10-34. 2,998 x 108)/ 250.10-9  = 7,946 x10-19  (Joule/photon)   (1) 
E(1000)= (6,626 x 10-34. 2,998 x 108)/ 1000.10-9  = 1,986 x10-19  (Joule/photon)  (2) 
 
1eV = 1,60207 x 10-19 Joule, so the photon energy expressed in eV/photon becomes: 
E(250) = 7,946 x10-19 /1,60207 x 10-19 = 4,9592 (eV/photon)    (3) 
E(1000)= 1,986 x10-19 /1,60207 x 10-19 = 1,2398 (eV/photon)    (4) 
 
Suppose we measure 20 ?Watt/cm2 at a certain wavelength 
 
20 ?Watt/cm2  = 20 ?Joule/s/cm2 = 0.2 Joule/s/m2  

= 0.2/(1,60207 x 10-19 ) eV/s/m2 
= 1,248 . 1018 eV/s/m2       (5) 
 

Knowing the photon energy at 250 nm and at 1000 nm from (3) and (4), the number of photons that 
correspond with 20 ?Watt/cm2 at 250 nm and at 1000 nm can be calculated from (5) by:  

 
for 250 nm : #photons = 1,248 . 1018 / 4,9592 = 2,517 . 1017  photons/s/m2 
for 1000 nm  : #photons = 1,248 . 1018 / 1,2398 = 1,007 . 1018  photons/s/m2 
   
With 1 mol = 6,02308 x1023 (Number of Avogadro)  
1 ?mol = 6,02308 x1017 

 
So, the number of photons, expressed in ?mol/s/m2, when measuring 20 ?Watt/cm2 at wavelength 250 
nm and also 20 ?Watt/cm2 at 1000 nm becomes: 
for 250 nm : 2,517 . 1017 / 6,02308 .1017  = 0,418 ?mol/s/m2 
for 1000 nm  : 1,007 . 1018 / 6,02308 .1017  = 1,672 ?mol/s/m2 
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Hardware Setup Parameter Unit Description 

inside sphere Radiant Flux 
(Power emitted) 

µWatt Total optical power emitted from a source 

inside sphere Energy emitted  µJoule Total optical energy emitted from a source, 
calculated by multiplication of the power with 
the integration time  

outside sphere or 
cc 

Radiant Flux 
(Power emitted) 

µWatt Total optical power emitted from a source, 
calculated by multiplication of radiant intensity 
with the solid angle of the light source 

outside sphere or 
cc 

Energy emitted  µJoule Total optical energy emitted from a source, 
calculated by multiplication of the power with 
the integration time  

outside sphere or 
cc 

Radiant 
Intensity  

µWatt/sr Optical power per unit solid angle, calculated 
by multiplication of irradiance with the square 
distance between point source and diffuser 
surface  

outside sphere or 
cc 

Radiant Energy  µJoule/sr Total optical energy emitted from a source, 
calculated by multiplication of the radiant 
intensity with the integration time  

outside sphere or 
cc 

Power received  µWatt Power received at diffuser surface 

outside sphere or 
cc 

Energy 
received  

µJoule Energy received at diffuser surface,  
calculated by multiplication of the power with 
the integration time  

outside sphere or 
cc 

Irradiance  µWatt/cm2 Power received per square centimeter  

outside sphere or 
cc 

Energy/cm2  µJoule/cm2 Energy received per square centimeter,  
calculated by multiplication of  irradiance with 
the integration time  

outside sphere or 
cc 

Photon Flux/m2  µmol/(s.m2) Photons received per second and per square 
meter,  see for calculation previous page 

outside sphere or 
cc 

Photon Flux µmol/s Photons received per second at diffuser 
surface 

outside sphere or 
cc 

Photons/m2 µmol/m2 Photons received per square meter during 
one integration time cycle 

outside sphere or 
cc 

Photons µmol Photons received at diffuser surface during 
one integration time cycle 
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Photometry 

Photometry is the measurement of visible light. Unlike radiometry, it is not a purely physical 
measurement and is calculated considering a „standard“ human visual perception. This is 
attained by multiplying the radiometric data by the luminous efficacy curve (see figure below) 
and integrating the product over the visible range (380 – 780 nm).  
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The three categories that were defined for the radiometric parameters can also be used for 
the photometric parameters. 

o The photometric equivalent for the Radiant Flux [µWatt] is the Luminous Flux, 
expressed in Lumens.  

o The photometric equivalent for the Radiant Intensity [µWatt/sr] is the Luminous 
Intensity, expressed in Lumens/sr. This unit is equal to Candela. 

o The photometric equivalent for Irradiance [µWatt/cm2] is called Illuminance, expressed 
in Lumens/m2. This unit is equal to Lux. 

Since the geometry of the three categories is the same for radiometry and photometry, the 
same can be written about the hardware setup: luminous flux can be measured inside an 
integrating sphere. When measuring a source at a certain distance from the integrating 
sphere or cosine corrector, the luminous flux can be calculated, assuming that the source is 
an isotropic point source. The Luminous Intensity [Candela] and Illuminance [Lux] of a sphere 
can be measured outside the integrating sphere or with a cosine corrector. 
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4.4.2 Quick Start 

Quick Start (1): Perform absolute irradiance measurements using a calibrated lamp 

1. Start the getSoft software, and click the “Start” button in the main window. 

2. Connect a fiber to the spectrometer input port.  

3. Start the absolute irradiance application software by clicking the menu option: “Application 
-> Absolute Irradiance Measurement”. Click the “Perform Intensity Calibration” button. 

4. Select the spectrometer channel that will be calibrated, the calibration lamp file and enter 
the diameter of the fiber/cosine corrector or integrating sphere sample port that is used, 
as described in section “4.4.4. Application: Absolute Irradiance ” 

5. Turn on the reference light source (e.g. getLight-HAL-CAL or getLight-HAL-CAL-ISP). If a 
cosine corrector is used at the end of the fiber, mount it directly on the reference light 
source. If an integrating sphere is used at the end of the fiber, put the integrating sphere 
sample port over the light output port. 

6. Verify that the calibration lamp is ON for at least 15 minutes, and click the “Start Intensity 
Calibration” button. Try to adjust the integration time while looking at the reference light, 
such that the maximum count over the wavelength range is around 14000 counts. It is 
also possible to let getSoft search for an optimal integration time by clicking the “?AC” 
button. 

7. Adjust the smoothing parameter to optimize smoothing for the fiber/slit diameter that is 
used. 

8. If a good reference signal is displayed, click the white “Save Reference” button. A white 
line will mark the reference spectrum. Then switch off the calibration lamp, wait until the 
spectrum becomes flat, near the bottom of the scale, and click the black button to save a 
dark spectrum. A black line will mark the dark spectrum.  

9. Click the “Save Intensity Calibration” button. A dialog opens in which the current settings in 
this intensity calibration are shown. If the calibration has been performed with diffuser, the 
intensity calibration data will be saved to an ASCII file with extension *.dfr, with bare fiber 
this extension will be *.fbr. The name of the intensity calibration file can be entered after 
clicking the “Save As” button. With USB2 spectrometers, the intensity calibration can also 
be saved to EEPROM by clicking the “Save to EEPROM” button. Click the “Close” button 
to close the dialog. 

10. Switch to the Irradiance Chart TAB to enter the hardware setup and select the 
colorimetric, radiometric, photometric and/or peak parameters of interest (see section 
“4.4.5.1 Irradiance Chart Settings”). Then click “OK”.  

11. Measure the output parameters in the experiment. If needed, change the integration time, 
such that the maximum in scope mode is around 14000 A/D counts . Block the light path 
to the spectrometer, and save a dark spectrum. If the (ir)radiance of the light to be 
measured needs to be displayed against time, click the time measurement TAB in the 
settings dialog as described in section “4.4.6 Time Series Measurement”. 

12. The intensity calibration as performed under point 9 can be loaded in future experiments 
by selecting the option “Load Intensity Calibration”, as described below under Quick Start 
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(2). For the USB2 spectrometers, the intensity calibration that has been stored in the 
EEPROM is loaded automatically during the initialization of getSoft. After loading an 
intensity calibration, a dark spectrum needs to be saved before switching to Irradiance 
mode. 

Quick Start (2): Perform absolute irradiance measurements by loading an intensity 
calibration 

1. Start the getSoft software, and click the “Start” button in the main window. 

2. Connect the same fiber (and diffuser or integrating sphere) that was used during the 
intensity calibration that will be loaded to the spectrometer input port. 

3. Start the absolute irradiance application software by clicking the menu option: “Application 
-> Absolute Irradiance Measurement”. If an intensity calibration has been stored in 
EEPROM before (USB2 platform only), this will be auto loaded at getSoft program 
initialization. Click the “Load Intensity Calibration” button. A dialog shows up in which the 
intensity calibration file can be selected. Select the file and click the “Open” button. 

4. Switch to the Irradiance Chart TAB to enter the hardware setup and select the 
colorimetric, radiometric, photometric and/or peak parameters of interest (see section 
“4.4.5.1 Irradiance Chart Settings”). Then click “OK”. 

5. Measure the output parameters in the experiment. If needed, change the integration time, 
such that the maximum in scope mode is around 14000 A/D counts. Block the light path 
to the spectrometer, and save a dark spectrum. If the (ir)radiance of the light to be 
measured needs to be displayed against time, click the “Time Measurement TAB” in the 
settings dialog as described in section “4.4.6 Time Series Measurement”. 

4.4.3 Load Intensity Calibration 

By selecting the menu option 
“Application -> Absolute Irradiance 
Measurement” a window is shown in 
which the intensity calibration that 
was saved before can be loaded by 
clicking the “Load” button. An 
intensity calibration file contains the 
data which is necessary to convert 
the Scope data to Irradiance data. If 
the spectrometer system has one or 
more slave channels, it is important 
to know that the calibration data for 
each spectrometer channel are 
saved in a separate file. To measure irradiance data at more spectrometer channels 
simultaneously, the calibration files for each spectrometer channels needs to be loaded first. 
After loading an intensity calibration file, a graph is displayed which shows the data transfer 
function for the loaded channel. The irradiance spectrum is calculated by multiplying the 
measured scope data (from which a saved dark spectrum is subtracted) with this data 
transfer function.   
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If the intensity calibration has been loaded, the “Irradiance 
Chart” and “Irradiance Time Series” tabs will be enabled. 
Clicking one of these tabs allows you to change the settings 
for the irradiance chart or time series measurements, after 
which the measurements can be started by clicking the “OK” 
button. The irradiance chart and time series settings are 
described in sections “4.4.5 Irradiance Chart” and “4.4.6 Time Series Measurement”. 

4.4.4 Perform Intensity Calibration 

If a calibrated light source such as the getLight-HAL-CAL or getLight-DH-CAL is available, an 
intensity calibration can be performed. By selecting 
the menu option “Application -> Absolute Irradiance 
Measurement”, a window is shown in which the 
settings for the intensity calibration become visible 
after clicking the “Perform Intensity Calibration” 
button. The following settings need to be entered 
before starting the intensity calibration: 

o Spectrometer channel  

o Calibration Lampfile 

o CC-UV/VIS, fiber or integrating sphere sample 
port diameter 

For a single channel spectrometer, the spectrometer 
channel will always be set to “Master”. For multi-
channel spectrometer systems, the spectrometer 
channel for which the intensity calibration will be 
performed can be selected from the list (Master, 
Slave1…). 

Calibration Lamp 

The energy output (in µWatt/cm2/nm) for 
the calibration lamp that will be used can 
be found in a file with the extension *.lmp. 
This file needs to be selected by clicking 
the “Select” button.  

After the calibration file has been selected, 
the data can be viewed, edited and/or 
saved under a different filename by 
clicking the “View/Edit Lamp Data” button. 

A dialog with the intensity versus 
wavelength values for the selected calibration light source is shown, as well as a graph in 
which the intensity is displayed versus wavelength: 



 

 
info@getSpec.com 

 
Tel. : +49 (0) 351 871 8423   Tél. : +33 (0) 4 72 80 82 02   Tel. : +49 (0) 231 974 2285   
Fax : +49 (0) 351 871 8465   Fax : +33 (0) 4 72 80 82 43   Fax : +49 (0) 231 974 2286 
             
    

• Dresden • Lyon • Dortmund • Sofia 
Seite 88 

 

 

…more than spectroscopy! 

 
If needed, the data can be edited and saved under another filename by clicking the “Save 
As …” button. Before the changed data takes effect, the new filename needs to be loaded 
with the select lamp option described above.  

CC-UV/VIS, Fiber or integration sphere sample port diameter 

The hardware setup for which the calibration lamp has been calibrated (CC-UV/VIS cosine 
corrector, bare fiber or integrating sphere), should match the hardware setup that is used 
during the intensity calibration. The diameter of the cosine corrector (3900 micron), bare fiber, 
or getSphere (6000, 10000 or 15000 micron for respectively getSphere-30, getSphere-50 and 
getSphere-80) needs to be entered in micron.   

It is important that the hardware setup 
that is used during the calibration, is 
the same as the hardware setup in the 
(ir)radiance measurements. 

4.4.4.1 Start Intensity Calibration 

Verify that the calibration is ON for at 
least 15 minutes, and that the 
hardware has been setup correctly. 
Then click the button “Start 
Calibration”.  

As a result, the Scope data (A/D 
Counts) for the selected spectrometer 
channel will be displayed graphically. 

Set the smoothing parameter to 
optimize smoothing for the fiber/slit 
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diameter used (see also section “3.2.3 Setup Menu: Smoothing and Spline”). 

Set the integration time such that a good reference signal (maximum around 14000 – 15000 
counts) is measured. It is also possible to let getSoft search for an optimal integration time by 
clicking the “Auto Configure Integration Time (?AC)” button. 

Set the number of scans to average to a high number to reduce the noise during the intensity 
calibration. 

If a good reference signal is displayed, click the white “Save Reference” button in the dialog 
above. A white line will mark the reference spectrum. Then switch off the calibration lamp, 
wait until the spectrum becomes flat, near the bottom of the scale, and click the black button 
to save a dark spectrum. A black line will mark the dark spectrum. 

4.4.4.2 Save Intensity Calibration 

If reference and dark data have been saved in the figure above, the intensity calibration can be 
saved by clicking the “Save Calibration” button. 

A dialog shows up in which the current 
settings in this intensity calibration are 
shown. If the calibration has been 
performed with diffuser, the intensity 
calibration data will be saved to an ASCII file 
with extension *.dfr, with bare fiber this 
extension will be *.fbr. The name of the 
intensity calibration file can be entered after 
clicking the “Save As” button. For USB2 
platform spectrometers, the intensity 
calibration can be saved to EEPROM by 
clicking the “Save To EEPROM” button. 

The following data will be saved to the 
intensity calibration file: 

o Name of light source calibration file (*.lmp) 

o Spectrometer channel (0 = Master, 1 = Slave1 etc.) 

o Integration time in milliseconds 

o Diameter of diffuser surface in microns 

o TOTAL_PIXELS (= 2048 for getSpec–2048) values, which represent the dynamic 
range (reference minus dark data) at each pixel during the intensity calibration, divided 
by the intensity of the calibrated light source that was used. 

o Setting for the Smoothing parameter during the intensity calibration. 

After an intensity calibration has been performed, a graph is displayed which shows the data 
transfer function for the spectrometer channel. The irradiance spectrum is calculated by 
multiplying the measured scope data (from which a saved dark spectrum is subtracted) with 
this data transfer function.   
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If the intensity calibration has been performed, 
the “Irradiance Chart” and “Irradiance Time 
Series” tabs will be enabled. Clicking one of 
these tabs allows you to change the settings 
for the irradiance chart or time series 
measurements, after which the 
measurements can be started by clicking the 
“OK” button. The irradiance chart and time 
series settings will be described in sections 
4.4.5 and 4.4.6. 

 

4.4.5 Irradiance Chart 

4.4.5.1 Irradiance Chart Settings 

After an intensity calibration has been performed or loaded, the “Irradiance Chart TAB” 
becomes available in the Irradiance Settings dialog. By clicking the TAB, the Irradiance Chart 
settings are displayed. The figure at the right shows the default 
settings for Spectrometer Channel, Hardware Setup, Parameter 
group, Graphics and Save Settings.  

The Spectrometer Channel setting can be changed, if for a multi-
channel spectrometer system calibrations have been performed or 
loaded for more than one channel. 

The Hardware setup setting is an important parameter, because as 
described in section “4.4.1  Background” it determines the 
radiometric and photometric parameters that can be measured, as 
well as the way these are calculated. If getSphere is used, it is 
important to know if the light source is measured inside the sphere 
(like often is done with LED’s), or outside the sphere. This setting 
can be entered after clicking the getSphere button and then inside 
or outside sphere. 

The Parameter group setting determines which parameters will be 
shown in the irradiance chart. By clicking one of the group 
parameters, the detailed settings for this group become visible. A 
description about these parameters and how they are calculated 
can be found in section “4.4.1  Background”. 

By default, only the Colorimetric parameters are enabled. 

 
The parameters that are enabled in the figure above will be displayed in the Irradiance Chart. 
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The detailed setting for the radiometric parameters is done while measuring, in the irradiance 
chart dialog. If the hardware setup is not “Source Inside Sphere”, you can already select if you 
want to measure only radiometric parameters received at the diffuser surface, or also 
calculate the power and/or energy emitted by the source. An important assumption when 
calculating the emitted power or energy is that the source should be an isotropic point source. 

 
If the hardware setup is “Source Inside Sphere”, the detailed setting for the radiometric 
parameters (emitted power in µWatt or emitted energy in µJoule) is done while measuring, in 
the irradiance chart dialog. 

The same difference in hardware setup determines which photometric parameters can be 
measured. If the hardware setup is not “Source Inside Sphere”, the Illuminance in Lux can be 
measured. The Luminous flux (the photometric equivalent of radiometric Power) can be 
measured at the diffuser surface, but it can also be calculated how much lumens are emitted 
by the source. An important assumption is that the source should be an isotropic point 
source. In this setup the Luminous Intensity in Candela can be measured as well. If the 
hardware setup is “Source Inside Sphere”, only the Lumens emitted by the source can be 
measured. 

 
The peak parameter group allows you to enable/disable the following peak information.  

 
Detailed settings, like the wavelength range and the radiometric 
output parameter for which the peak(s) are calculated can be 
done in the Irradiance chart dialog.  

The Graphics setting determines which graph will be displayed 
in the irradiance chart dialog. 

The Save Settings are used to enter the name of the text file to 
which the results of the irradiance chart measurements will be 
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saved. By default this name is irrchart.txt, but by clicking the “Change Output File” button, this 
filename can be changed.  

By enabling the “Save Irradiance Spectrum” option, a complete irradiance spectrum will be 
saved together with the parameter results. The name of the irradiance spectrum file will start 
with the filename that has been entered (irrchart in the figure at the right), followed by a 
sequence number and the extension *.irr. The irradiance spectrum files can be saved and 
loaded from the irradiance chart dialog. 

If all settings have been entered, the measurements can be started by clicking the “OK” 
button. To be able to measure the right A/D counts (corrected for the dark spectrum), a 
warning will be displayed if a dark spectrum has not been saved: 

 

4.4.5.2 Irradiance Chart Display  

The irradiance chart displays the graphics and output parameters that were selected in the 
settings dialog. Moreover, up to ten radiometric parameters can be selected, each with a user 
defined wavelength range. The measurement results can be saved, and earlier saved spectra 
can be graphically displayed and compared to the measured spectrum. The integration time 
and number of scans to average can be changed to optimize the AD Counts for each sample.  

 
The figure above shows a result for a typical LED measurement inside getSphere. 

If the light source is measured outside the sphere or with a cosine corrector, and the radiant 
flux [µWatt], radiant intensity [µWatt/sr], luminous flux [Lumens] or luminous intensity 
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[candela] need to be calculated, then the distance [meter] and geometry of the lamp 
[steradians] can be entered in the irradiance chart window as well. The geometry of the point 
source is default 4p steradians and is needed only for the radiant and luminous flux 
calculations.  

 
In this section, the following items from the irradiance chart window will be described:  

o Add/Edit radiometric parameters 

o Graphics 

o Button bar 

The other output parameters are displayed according to the settings in the irradiance chart 
settings dialog. More information about all output parameters can be found in section “4.4.1 
 Background”. 

Add/Edit Radiometric Parameters 

There are two ways to monitor the radiometric parameters. The first one is by defining up to 
ten different parameters or wavelength ranges in the radiometry box at the right side of the 
irradiance chart window. The second one is by selecting a radiometric parameter in the graph 
after which the spectrum for the selected parameter will be displayed (see below under 
graphics). 

To define an output parameter at one of the ten lines in the radiometry box, simply double 
click the line or click the “Edit” button on top 
and enter the line number. A dialog will be 
shown in which the radiometric parameter 
and wavelength range can be specified.  

The wavelength range is the spectral range 
over which the radiometric output will be 
integrated. For example, by specifying the 
UV-C, UV-B and UV-A wavelength ranges at 
three different lines, the irradiance for these 
spectral ranges can me measured 
simultaneously (assuming the spectrometer 
wavelength range includes the specified 
ranges and has also been calibrated for 
these ranges). 

Note that the available parameters depend on the settings in the irradiance chart settings 
dialog. For example, to be able to measure the radiant intensity, the “Calculate Power and/or 
Energy emitted by a source” option should be enabled.  

 

Graphics 
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Chromaticity Diagram  

The chromaticity 
diagram is used to 
visualize the 
colorimetric 
measurements. 
According to what has 
been selected in the 
irradiance chart 

settings dialog, it will display the locus for the 2 or 10 
degrees standard observer. The measured (x, y) 
coordinates will be displayed in the diagram and a line 
will be drawn from the midpoint (x = y = 1/3) through 
the measured (x, y) to the edge of the locus, which represents the dominant wavelength. 

The scope data graph displays the raw A/D counts that are received from the spectrometer. 
This graph can be used to determine if a good integration time has been set. If the integration 
time is too low, the radiometric spectrum will be noisy, if the integration time is set too high, 
the spectrometer detector can be saturated, in which case a saturated label will appear in the 
Scope Data Graph. 

The radiometric graph displays the spectrum for the selected radiometric parameter. Just like 
with selecting the radiometric parameter in the radiometry box, the available parameters 
depend on the settings in the irradiance chart settings dialog. In the figure at the right, an LED 
is measured inside an integrating sphere, in which case only the Radiant Flux (emitted power 
in µWatt) and the emitted energy during one integration cycle (in µJoule) can be selected. See 
also the radiometric table in section “4.4.1  Background”. The selected parameter in the 
radiometric graph is also used to determine the peaks in the peak measurement box.  

The radiometric spectra can be saved and loaded by the “Save” and “Open Saved Graph” 
buttons (see below under button bar). 

Button bar 

The “Exit” button will close the irradiance chart and return to the getSoft main window. 

The “Pause” button will stop data processing to be 
able to take a snapshot at the spectrum and/or 
output parameters. 

The “Info” button shows information about the 
current settings, as shown in the dialog left. 

The last line in this dialog: “Save irradiance 
spectrum?: Yes” refers to the save setting in section 
“4.4.5.1 Irradiance Chart Settings”. If this option is 
enabled then all (displayed) parameters will be 
saved in this example to irrchart2.txt and the 
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spectrum for the selected parameter in the radiometric graph will be saved to irrchart2xxxx.irr, 
in which xxxx represents the sequence number. 

If the “Save irradiance spectrum” option is not enabled, only the displayed output parameters 
will be saved. 

By clicking the black “Save Dark” button, a new dark spectrum will be saved. It is 
recommended to save a new dark spectrum each time after changing the integration time.  

Clicking the “Save 
Data” button will add 
the measured data to 
the text file. An user 
comment can be added 
to the saved data. If a 
radiometric spectrum 
has been saved with 
the output parameters, 
the name of this file is 
also saved in the text 
file.  

 

 

The “Display Saved Graph” button can be clicked to load a radiometric spectrum that was 
saved before. In the open file dialog, the radiometric spectra that were saved before will be 
listed. By single clicking a file name, the comment for this file will be displayed in the graph. 
By double clicking the file name, or by clicking the “Open” button, the radiometric spectrum 
will be displayed. This can be repeated for a second filename, which allows you to compare 
the output of the two spectra graphically. The online measured spectrum will be displayed in 
the same graph and can be compared to earlier saved spectra as well.  
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The filename and comments for the displayed spectra appear on top of 
the graph, the text colors are the same as the colors used to draw the 
spectra. By clicking the (blue or green) filename with the right mouse 
button, a popup menu for this radiometric spectrum is presented, with 
the menu options shown in the figure at the right:  

The “Show Info” menu option displays the hardware settings, measurement parameters and 
save settings for the spectrum, as shown in the dialog at the left. 

The measurement parameters displays the unit of the intensity of the displayed saved 
spectrum. This can be a different unit than the selected unit for the online measured spectra. 
Also, if comparing two saved spectra graphically, be aware that these were saved in the 
same radiometric unit. 

The other menu options in the popup menu, “Convert to ASCII” and “Convert to Excel” can be 
used to export the data from the (binary) file with 
extension *.IRR to a textfile (*.txt) or to a file that can 
be opened with Excel (*.xls).  

The “Remove from Chart” menu option clears the 
saved spectrum. 

At the right side of the button bar, the integration time 
and number of scans to average can be changed. The 
“Auto Configure Integration Time” button can be used 
to let getSoft search for integration time such that the 
maximum output in scope mode (A/D Counts) will be 
around 14500 counts. Do not forget to save a new 
dark spectrum (black button) after changing the 
integration time. 

4.4.6 Time Series Measurement 

After an intensity calibration has been performed or loaded, the “Irradiance Time Series TAB” 
becomes available in the Irradiance Settings dialog. By clicking the TAB, the Irradiance Time 
Series settings are displayed.  

With time series irradiance measurements, up to 8 radiometric parameters can be followed 
simultaneously in a graph against time. The functions F1 to F8 can be selected by clicking the 
corresponding TAB sheet at the top of the Time Series settings dialog. 
Furthermore, a number of general (function independent) parameters can be entered, below 
of the function TAB sheets. The following features can be set separately for all functions F1 to 
F8: 
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o Enable/Disable function. The radiometric parameters can be set after clicking the 
“Enable” button. 

o Hardware Setup. The Hardware setup setting is an important parameter, because as 
described in section “4.4.1  Background” it determines the measurable radiometric 
and photometric parameters, as well as the way these are calculated. If getSphere is 
used, it is important to know if the light source is measured inside the sphere (like 
often is done with LED’s), or outside the sphere. This setting can be entered after 
clicking the “getSphere” button and then inside or outside sphere. 

o Spectrometer Channel. If the spectrometer system contains one or more slave 
spectrometer channels, for which also an intensity calibration has been loaded or 
performed, the spectrometer channel on which the output parameter will be measured 
can be selected from the drop down box at the left (showing by default “Master”). 

o Parameter. The number of available parameters and the way these are calculated 
depend on the hardware setup. The figure above shows the settings that are available 
when measuring with a cosine corrector, or with an integrating sphere at a certain 
distance from the light source. For each function F1 … F8, one of the 35 available 
parameters can be selected. See section “4.4.1  Background” for further 
information about these parameters. The colorimetric parameters can be calculated 
by using the 2 degrees standard observer values or the 10 degrees. If one of the 
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radiometric parameters is selected, the wavelength range needs to be specified. The 
wavelength range is the spectral range over which the radiometric output will be 
integrated. If the source is not inside an integrating sphere, the radiant intensity (in 
µWatts/sr) and radiant energy (in µJoule/sr) can be calculated if the distance from 
source to diffuser surface has been specified. The radiant flux (µWatts emitted) and 
emitted energy (µJoule e.) can be calculated if the geometry of the lamp (in 
steradians) is specified. Distance and Geometry can be entered if the parameter is 
selected for which these data entries are relevant. If one of the peak parameters is 
selected, the wavelength range needs to be entered over which the (highest) peak will 
be calculated. Moreover, the radiometric parameter should be specified to determine a 
peak parameter. Photometric parameters do not need a wavelength range because 
for these parameters the range is always from 380 to 780 nm. However, since emitted 
Lumens and Candela are the photometric equivalent of radiant flux and radiant 
intensity, the geometry (for emitted Lumens) and distance (for emitted Lumens and 
Candela) needs to be specified if the source is not measured inside an integrating 
sphere. If a source is measured inside an integrating sphere, the radiometric 
parameters that can be measured are limited to radiant flux (µWatts emitted) and 
emitted energy (µJoule e.), and the photometric parameter that can be measured in 
this hardware setup is emitted Lumen. 

o Function display settings. The parameters that have been set in the functions can 
be displayed graphically against time. The amount of time that will be displayed at the 
x-axis can be set manually under the x-axis setting. The y-axis can be set to a fixed 
range or to Autoscale. The Autoscale option will set the y-axis range to the minimum 
and maximum function values that are in the list of measured data points.   

Function Independent Parameters 

 

Function Independent Parameters - Display no graphics to speed up data processing 

Below the TAB sheets for function definition an option can be enabled or disabled to speed up 
data processing by not displaying the graphics during the measurements. If an application 
requires fast data processing, this option should be enabled. If saved to an output file, the data 
can be displayed graphically after the time series experiment has been ended, as described 
in section “4.1.3 History Application: Display Saved History Graph”. 

Function Independent Parameters - Save Function Output 

The results of a time series color experiment will be saved to an ASCII-file if the radio button 
“Save Function Output” has been selected. A number of seconds between saving can be 
entered for data reduction, in case measurements are carried out over long periods. Entering 
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a value of zero results in saving every scan. The name of the file to which the data will be 
saved, can be changed after clicking the 
“Change Output File …” button. 

Last option in the “Save Function Output” 
box is to enable or disable the possibility to 
create a backup file during the 
measurements. If this option is enabled, 
getSoft will create a backup file with the 
same filename, but with the extension *.bak 
(also in ASCII). This backup file is updated 
every scan and can be used in case the 
filename that has been selected has failed 
to save the data, for instance because of a 
power failure during the measurements.  

Save ICF / Load ICF buttons 

getSoft automatically saves all parameters (irradiance parameters, save options) to the file 
irrtime62.ini, and restores these parameters, the next time getSoft is started. With the “Save 
ICF” and “Load ICF” buttons, it is also possible to save these parameter settings to (and load 
from) a file with the extension*.icf. With this feature it is possible to save for each experiment 
a different *.icf file, so it can be loaded a next time the same settings are required.  

After the definition of one or more functions, the “OK” button is clicked to start measuring, the 
“Cancel” button to leave the dialog and return to getSoft’s main window.  

After starting the irradiance measurements by clicking “OK”, the output of the selected 
parameters will be displayed against time. If the option “Display no graphics to speed up data 
processing” has been marked in the function entry dialog, the function output will be shown by 
numbers only, which are updated each time a new scan is saved to the output file.  

There are six buttons at the top of this window (see figure below): an “Exit” button, a 
“Pause/Start” button, a “Save Reference” button, a “Save Dark” button, an “Info” button and a 
“Print” button.  

If the red “Exit” button is clicked, the time measurements are ended and the main window and 
menu is activated. The yellow “Pause” button can be used to stop the time measurements 
temporarily. After clicking the “Pause” button, data acquisition stops and the text on the button 
changes to a green “Start”. If the “Start” button is clicked, data acquisition is activated again 
and the text changes back to the yellow “Pause” again. 

The “Save Reference” and “Save Dark” buttons have the same functionality as in the main 
window.  

The “Info” button shows the dialog, in which all parameters can be viewed (not edited) while 
the measurement is running. 

By clicking the “Print” button, the graphics that are displayed can be printed during the run. 
First the printer specific dialog shows up in which the print options can be set. For example, if 
only one graph of the four in the figure above need to be printed, this graph can be selected by 
the page(s) radio button. All graphics are printed full size on a different page. 
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If time measurement data have been 
saved, the resulting ASCII-file can be 
displayed graphically by selecting this file 
in the dialog that is shown after clicking 
the menu option “Application -> History -> 
Display Saved History Graph”. After 
clicking the “Open” button in this dialog, 
the function output is displayed against 
time. Both x- and y-axis are set to their full 
scale, which is determined by the 
minimum and maximum values in the list. 

Zoom features 

In each graph the same zoom features 
apply as in the main window (except for 
scaling the y-axis with the mouse wheel). 
However, zooming in over the x-axis while 
the measurement is running and the x-axis is already scrolling will not be possible, because in 
that case the x-axis is updated with each new scan. Clicking the “Pause” button to take a 
snapshot will solve this problem. 

Zoom in: Select a region to be expanded to the full graph. To select this region, click the left 
mouse button in the white graphics region and drag it downwards and to the right. After 
releasing the left mouse button, both the x- and y-axis will be rescaled to the new values of 
the selected region. 

Zoom out: Drag with the left mouse button within the white graphics region, but in stead of 
dragging the mouse downwards and to the right, drag it into another direction. After releasing 
the mouse button, both the x- and y-axis will be reset to their default values. 

Move X-Y: Dragging with the right mouse button results in moving the complete spectrum up 
or down and to the left or right. 

4.5 Application: Excel Output 

getSoft XLS is an add-on application that enables getSoft Full to output history channel data 
and/or complete spectra to Microsoft Excel. 

It uses OLE-Automation, which is a technology that enables getSoft to remotely control Excel, 
opening sheets and copying data into cells. 

On modern hardware, we have been able to copy complete 2048 pixel spectra to Excel with 
as little as 50 msec overhead per scan. 

4.5.1 Select Source Data 

Besides enabling Excel output, you will have to select your source data. 
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This is done in the same way it would be done without the Excel output option, with the input 
screens you use to define History Channel Functions, and Time Series in the Color and 
Irradiance applications. 

The only difference is the “Save Function Output” box, which is not used by the Excel Output 
option. This part is replaced by a separate dialog, which will be described under “Settings”. 

4.5.2 Enable Excel Output 

Enable the option by selecting „Application -> Excel Output -> Enable“. 

A checkmark will appear before the menu entry „Enable“ to show the status of the option. 

4.5.3 Settings 

getSoft will write the data to three differently formatted sheets, depending on user input in 
History Channel Function Entry and the Settings dialog. 

You can enter the Settings dialog by selecting „Application -> Excel Output -> Settings“. 

 
First, select the mode you want. 

Export Mode 

You can select the “Export Mode” by selecting the radio button “Export a fixed number of 
scans to Excel”. In this mode, a predefined number of scans will be logged to new 
worksheets that Excel will open. 

Depending on your choice of history channel, one of two formats of sheet (or both) will be 
opened by Excel. 

If you select regular history channels, without selecting “View Spectrum“, the sheet will be 
formatted horizontally, with the program adding a new row for each measurement written. 
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The sheet will be called “getSoft Data“, the columns contain the following data: 

Column A contains a data/time value, formatted as “dd:mm:yyyy hh:mm:ss“. 

This is a floating point value, in which the integer part is the day number, starting at January 1, 
1900 with day 1. The fractional part represents a decimal time value, where 0.5 is 12:00 h 
noon and 0.75 is 18:00 h. 

This way, differences in date/time can be readily calculated by subtracting values, which 
would be much more difficult if this was a text representation. 

Column B contains a time value, representing the elapsed milliseconds since midnight. This 
value does not have a one millisecond resolution. Remember that Windows is not a real-time 
operating system. It can, however, be used as a reasonably accurate indicator of the time that 
passes between scans. 

Columns C through J contain the 8 different History Channel values. For unselected History 
Channels, a value of 0 will be entered in the sheet. 

If you select “View Spectrum“ in your choice of History Channels, the sheet will be formatted 
vertically. As Excel only offers 256 columns per sheet, we need to write a spectrum (which 
can hold more than 2000 pixels) in a column instead of a row, and add more columns as time 
passes. 
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Since there is a maximum of 256 columns per sheet, new sheets will be added after column 
256 (“IV“) is filled. 

The first sheet will be called F1 for history channel 1, F2 for history channel 2, etc. If extra 
sheets are added, a suffix will be added to this name, e.g. F1_01, F1_02 etc. 

If the function type “View Spectrum” has been selected for more than one History Channel 
Function (e.g. Master channel for F1, Slave1 channel for F2), then the different history 
channel sheets (named F1 and F2) are located in separate workbooks, and must be saved 
under separate filenames. This is also the case for the sheet with 8 History Channel values, 
described before. 

Rows 1 and 2 contain the date/time stamp and the elapsed millisecond value, as described in 
the previous section. 

Column A of the first sheet holds the wavelength scale. The wavelength range matches the 
wavelength range as specified in the History Channel Functions.  

The lower left half of the Settings dialog can be used to enter the number of scans you want 
to export to Excel, and the time interval (in seconds) between two scans you want to log. 

Default values are 1000 scans and no interval, meaning as fast as possible. 

Continuous Mode 

You can select continuous mode by selecting the radio button “Continuously overwrite data to 
a fixed position in an existing workbook” in the Select menu. In this mode, data will be written 
to a single sheet, each scan overwriting the previous one. 
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In the lower right part of the Settings dialog, you can select the workbook the sheet will be 
added to, thereby enabling you to use your own calculations and graphs in Excel on live data 
from getSoft. 

Click the “Select File“ button to select the workbook. Please save an empty workbook using 
Excel if you do not have a previous workbook to open. 

 

 
 
getSoft will check if a sheet named “getSoft Data“ is present, and will add this sheet if it is not 
present. This way, links to the sheet can be preserved between sessions. 

The sheet contains the following data, at fixed positions: 

A3   : Date / Time stamp 

This is a floating point value, in which the integer part is the day number, starting at January 1, 
1900 with day 1. The fractional part represents a decimal time value, where 0.5 is 12:00 h 
noon and 0.75 is 18:00 h. This way, differences in date/time can be readily calculated by 
subtracting values, which would be much more difficult if this was a text representation. 

B3  : Time in milliseconds after midnight 

This value does not have a one millisecond resolution. Remember that Windows is not a real-
time operating system. It can, however, be used as a reasonably accurate indicator of the 
time that passes between scans. 

C5-C*** : Wavelength scale (in nm) for first History Channel spectrum 
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D3  : Value for first History Channel (0 if spectrum is selected) 

D5-D*** : Spectrum for first History Channel.  

E5-E*** : Wavelength scale (in nm) for second History Channel spectrum 

    (empty if spectrum is not selected) 

F3  : Value for second History Channel  

F5-F*** : Spectrum for second History Channel 

    (empty if spectrum is not selected) … 

*** : depends on the wavelength range selected. 

4.5.4 Start Output 

You start the output the usual way, with “Application -> History -> Start measuring“. 

You can also use the corresponding button on the button bar. 

Please do not perform large alterations of the worksheet, 
while data is being transmitted. An error “Call was rejected 
by callee“ will be issued if Excel is too busy. 

Moving around the worksheet should not pose any 
problems. 

Save any alterations to your worksheet before starting the 
transfer to Excel. You do not have to close the worksheet or close Excel. 

4.5.5 Stop Output 

If you want to stop the transfer to Excel give focus to getSoft and press “Exit“. It may take a 
few seconds before the buttons appear.  

 
Excel will not be closed by getSoft. Save your work and close Excel the same way you would 
when working with Excel manually. 

We have included a sample worksheet, called “Continuous.xls“, which demonstrates linking 
to the “getSoft Data“ sheet. In this case, two graphs are drawn from the columns for Channel 
1 and 2. The graph and data are continuously updated while data is being transferred to 
Excel. 
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4.5.6 Limitations and Optimization Notes 

As all scans are stored in memory, it is very easy to overflow internal memory with scans in 
Export mode. 

Therefore, a limit to the number of scans to store in Excel has been built in. Before a new 
sheet is added, the amount of memory Excel uses is determined. If this number is larger than 
half the physical memory installed in the machine, output to Excel will stop. 

On a 128 MB machine, this corresponds with 7 - 8 complete sheets of 256 columns and 2000 
rows, roughly 2000 full scans. Limiting the wavelength range will extend your range of scans 
accordingly. 

Of course, adding more RAM to your machine will also help raise this limit.  

We have, however, seen limitations in the amount of memory that Excel can use. It looks like 
there is an internal limit that is hit before internal memory runs out. 

In a machine with 512 MB, the limit corresponds with about 16 sheets of complete 2000 pixel 
spectra. After this Excel issues an „Out of Memory“ message and is no longer functional. E.g. 
saving your data to disk is not possible anymore. 

This is only an issue on machines with large amounts of memory (256 MB, 512 MB) 

For greatest speed, it is important to give the focus to Excel. If you set the focus to getSoft, 
Windows will dramatically lower Excel’s priority. You can verify this by looking at the “Filling 
Cells“ progress bar in the lower left corner of your worksheet. 
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4.6 Chemometry 

getSoft-Chem was developed to enable on-line concentration measurements with a 
spectrometer system. 

According to Lambert-Beer’s law, there is a linear relationship between absorbance and 
concentration: 

lcA ??? ?  

Where A is the absorbance (or extinction), e is the extinction coefficient of the compound to 
be measured, c is the concentration and l is the optical path length. 

In practice, this relationship is only linear at reasonably low absorbance levels (say less than 
2). The wavelength at which the absorbance is measured must of course be kept constant. 

To take concentration measurements, you will need a spectrometer with either a cuvette-
holder or a dip-probe and a suitable light source. 

If you use cuvettes, remember that glass cuvettes will absorb UV light. If your wavelength is in 
the UV range, use quartz or polystyrene ones instead. 

getsoft-Chem can display and save the calculated concentration in two ways: 

o The concentration can be displayed on-line in a separate display window, for up to 
eight spectrometer channels (if available). 

o You can select up to eight history channels that can display and save concentration 
values against time. This application can be combined with the Excel and Process-
Control applications. 

4.6.1 Quick Start: How to make concentration measurements with getSoft-Chem 

1. Start the getSoft software and click the “Start” button in the main window. 

2. Set up the absorbance experiment with a cuvette holder or a dip-probe measuring the 
sample with the lowest concentration, usually your reference. Switch on the light source. 

3. Adjust the integration time to get a good reference signal with a maximum around 14500 
counts. The easiest way to do this is by using the “AutoConfigure Integration time” option. 

4. Adjust the number of averages. The higher the better, however the time for a single 
absorbance reading must remain practical. If you want to change it, first press the “Stop” 
button, and press the “Start” button again after changing the average value in the edit-bar. 

5. Switch off the light source and save a dark spectrum, switch it on again and save a 
reference.  

6. Change to absorbance mode by clicking the “A“ button in the button bar. Measure the 
absorbance of a sample with a high concentration to find the wavelength and bandwidth of 
an absorbance peak to use (most of the time, the wavelength with the highest absorbance 
is used. 

7. Calibrate your absorbance readings in the “Chemometry Settings“ form (section 4.6.2). 
You can also just use a previous calibration line, as it can be saved to disk under an user 
defined filename and reloaded at the start of the application. 
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8. Enable the concentration measurements by selecting “Application -> Chemometry -> 
Enable“ from the main menu. After the application is enabled, it is also possible to select 
“Chem“ as a History Channel function. 

4.6.2 Calibration Settings 

The dialog at the right is shown after selecting “Application -> Chemometry -> Settings“ for 
the first time. An example calibration file (example0.cal) has been created in the folder 
“chem”, which holds the data that is presented in the dialog. Note that the example is only 
illustrative. You need to measure 
a number of samples with known 
concentration to create your own 
calibration file(s), as described in 
section 4.6.2.1. After a calibration 
has been saved, it will be loaded 
automatically the next time the 
application is started. Once a 
calibration has been saved, it 
can be loaded later on and 
modified if needed. Section 
4.6.2.2 describes how to modify 
a previous saved calibration file. 

4.6.2.1 Start New Calibration 

A new calibration is started by clicking the “Start New Calibration (Clear Data)” button. All data 
fields for the selected spectrometer channel will be cleared. Enter the wavelength for the 
measurements in the “Peak at“ field and the width of the peak that will be used in the “Width“ 
field. The program will integrate the absorbance values from “Peak minus Width” to “Peak 
plus Width” and uses this 
integral as the absorbance value 
in the concentration calculations. 

The unit of concentration can be 
entered in the „Conc. Unit“ field. 
This is just a text, no 
adjustments will be made if you 
change this value. 

Enter the known concentration 
values for the available 
standards in the central column 
of the calibration points table. 
You can include the reference 
sample with zero concentration 
in these measurements. 

After this, the dialog contains for 
example the data shown in the 
figure at the right. 
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If the zero concentration (reference) sample is included, like in the example at the right, set up 
the experiment to measure this reference. Use the keyboard or mouse to point out the row in 
the table for which sample the absorbance value will be measured. When moving through the 
rows in the table, the text in the button “Read Absorbance for point x”, will be updated for the 
sample that will be measured. In the example, we start with measuring the absorbance of 
point 1, which is the reference sample. Click the “Read Absorbance for point 1” button to 
import the measured absorbance into the left column in the table. If the reference is 
measured, the value should be very close to 0.000. The measured absorbance and 
corresponding concentration will be visualized as a new point in the graph. Now move the 
cursor in the table to the second row, setup the experiment for measuring the sample of 
known concentration for point 2 (30 mmol/l in the example above), and click the “Read 
Absorbance for point 1” button to import the measured absorbance into the left column in the 
table for point 2. Repeat these steps for the other samples of known concentration. For a 
linear calibration line, at least two samples are needed, but the more points added, the more 
reliable the calibration line will be. 

After the samples have been measured, click the “Calculate New Calibration Line” button. As 
a result, a red line will be fit through the measured data, and you will be asked to save the 
calibration or not. 

The figure at the right shows that the calibration line fits very well through the measured 
points, so click “Yes” to confirm and to save the calibration. 

If during the measurements an incorrect calibration point was measured, for example 
because of mixing up the samples or measuring the concentration at the wrong row, this will 
become clear from the graph. You can then select either directly the “No” button, or select the 
“Yes” button and modify the 
calibration line later on. 
After clicking “Yes”, a dialog 
is shown in which the name 
of the calibration file can be 
entered. Type in the name 
you will use for this 
calibration line (MyFirst in the 
figure at the right), then click 
the “Save” button. As a result 
the file MyFirst.cal will be 
created, and the calibration 
line will become the actual 
calibration line that will be 
used to calculate the 
concentration levels for the 
specified spectrometer channel (Master in the example).  

After a calibration line is 
saved, it will become the 
actual calibration line, which 
is blue colored. This actual 
line will be used for 
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concentration calculations. Also the calibration line coefficients are shown in the lower right 
corner of the dialog and the predicted concentration values that have been calculated by using 
the calibration coefficients, have been added for the standards into the right column of the 
table. 

By comparing the predicted values with the actual concentration values, you can get an 
impression about the quality of the calibration line. 

The actual calibration line will be automatically loaded the next time getSoft is started. By 
clicking the “Load” button, other calibrations that were saved before can be loaded after which 
the loaded calibration line becomes the actual line. 

4.6.2.2 Modifying a calibration 

The actual calibration line can be modified by changing the fit order of the calibration line or by 
adding or deleting calibration points.  

Fit order 

The default fit order is linear. Using a second order (parabolic curve) makes it possible to 
compensate for non-linearity in e.g. your dip-probe. To illustrate this, the calibration from the 
previous section was loaded (MyFirst.cal), and the fit order was changed from first order to 
second order. After clicking the “Calculate New Calibration Line” button, the new standard 
deviation showed a much better fit then the previous (linear) fit. After saving this calibration 
line to “MySecond.cal” the predicted 
concentrations showed also a much better fit 
for the quadratic model. However, certainly with 
this few calibration points, the second order 
option should be used with care, as it will 
happily draw a well fitting calibration curve also 
through outliers. 

Adding/deleting calibration points 

Adding and deleting calibration points from/to the actual calibration line is very simple and very 
well visualized in the graphical display. To add new calibration points to a calibration, just load 
the calibration file, move the cursor to the next row in the table (row 5 in our example), fill in 
the sample concentration in the center column and read the absorbance into the first column 
by clicking the “Read Absorbance for point 5” button. 

A new red point will mark the calibration point in the graph. New points can be added up to 30 
standard samples. The “Calculate New Calibration Line” will display a new red line next to the 
actual blue calibration line before raising the dialog with the question if the new calibration data 
should be saved or not.  

This may be helpful to see if the new points are correctly measured, or that one or more new 
points induce a strong increase of the standard deviation.  

For example, in the figure at the right the error was caused by typing in the value of 60 in the 
center column instead of the correct value of 40. To delete one or more calibration points 
from the actual calibration, just delete the value for that point in the left or second column. 
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4.6.3 Enabling the application 

Enable the application by selecting “Application -> Chemometry -> Enable“ from the main 
menu. A checkmark will appear before the menu entry to show that the option is enabled. 

A separate Concentration display will appear, for each spectrometer channel enabled.  

After enabling the chemometry application, you can select „Chem“ as a function type in the 
Function Entry dialog of the History application. 
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5 Help 

After clicking the menu option “Help -> Contents” the getSoft FULL manual will be displayed in 
HTML format. At the left side the Help Contents displays all sections to which the user can 
browse to a specific topic.  

 
Instead of browsing through the contents to a specific topic, the search TAB can be selected, 
as illustrated in the figure below. After typing in a keyword (e.g. “concentration”), and clicking 
the “List Topics” button, a list of all topics containing this keyword is shown. By selecting a 
topic at the left (double click), the information is displayed at the right, in which the keyword is 
marked in the text. 
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As described in section “4.1.1  History Application: Function Entry” the History Channel 
Functions have been extended with the possibility to define a function with the support of a VB 
Script. We have included a help file for VBScript for your reference. You can reach it from the 
main menu by selecting „Help -> VBScript“. It lists among other things all available operators 
and functions: 

 
Finally, the third Help submenu is the about box which shows some information about the 
getSoft version that is being used, the serial number of the spectrometer that is connected, 
the Windows version of the computer and the available memory: 



 

 
info@getSpec.com 

 
Tel. : +49 (0) 351 871 8423   Tél. : +33 (0) 4 72 80 82 02   Tel. : +49 (0) 231 974 2285   
Fax : +49 (0) 351 871 8465   Fax : +33 (0) 4 72 80 82 43   Fax : +49 (0) 231 974 2286 
             
    

• Dresden • Lyon • Dortmund • Sofia 
Seite 114 

 

 

…more than spectroscopy! 

Appendix A Troubleshooting 

How to rectify an incorrect (USB) installation 

Any USB device requires that the USB drivers need to be installed before the device is 
connected to the computer. If you accidentally connected the getSpec-2048 spectrometer to 
the USB port of your PC before installing getSoft, the USB drivers cannot be found, and the 
spectrometer cannot be found by the (later installed) 
software. To rectify an incorrect installation follow 
these steps:  

1. Navigate to the Device Manager. If you have 
Windows98, select Start | Settings | Control 
Panel. Double-click the System icon. Select the 
Device Manager tab. For Windows2000 
systems, right click on My Computer, select 
Properties, select Hardware tab and click on 
Device Manager button. 

2. Scroll down until you see Other devices 

3. Under Other devices you will see USB device 
with a large question mark, hit the remove 
button, or right click the USB device and select 
the uninstall option. 

4. A warning box will appear to ask if it is OK to 
remove the device, click OK. 

5. Unplug the getSpec–2048 spectrometer from 
your PC and reinstall the getSoft software. 

6. Now you can plug the getSpec-2048 spectrometer to the USB port again. Do not forget to 
connect the getSpec-2048 to the 12V power supply as well. Windows will display the 
“Found New Hardware” (USB device) dialog, and starts searching for the driver (this can 
take a few minutes). Depending on the 
Windows version, the “Files Needed” 
dialog at the right may come up, which 
allows you to browse to the directory 
where the USB driver is located. Click 
the Browse button and browse to the 
directory: 
C:\WINNT\SYSTEM32\DRIVERS and 
double click the getUsb.sys driver. 
Then click the OK button in the “Files 
Needed” dialog at the right to complete 
the installation. 

7. The getSoft software can now be started and will detect the spectrometer at the USB port. 
If not, please have a look at the Device Manager, which should contain the getSpec.com 

The file „getUSB.sys“ on getUSB 
Installation Disk is needed.  
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Spectrometer board under Universal Serial Bus controllers, as illustrated in the figure 
above.  

Do not hesitate to contact us if the problem remains unsolved.  


